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1 IntroducƟon

The SEcube™(Secure Environment cube)Open Security Plaƞorm is anopen source security-oriented
hardware and soŌware plaƞorm, designed and constructed with ease of integraƟon and holisƟc
security in mind.
The present secƟon provides a global overview of the SEcube™ Open Security Plaƞorm. In parƟc-
ular, it presents the evoluƟon of the project behind the plaƞorm, its assets (both on the soŌware
and the hardware side), its funcƟonaliƟes and the community and the academia program that are
growing around the SEcube™ .

1.1 The need for Open Security Plaƞorms

Nowadays, security is one of the biggest necessiƟes of theworld, because our lives resolve around
computers present everywhere. People are always connected, posƟng informaƟon about their
lives on Facebook, Instagram, TwiƩer and tens of other social and communicaƟon networks. At
the same Ɵme the most part of enterprises has their infrastructure fully computerized. All the
transacƟons and important informaƟon are in personal computers or servers placed and intercon-
nected everywhere around the world. Such a scenario provides endless opportuniƟes to cyber-
aƩackers, which have been dramaƟcally increasing in number every day.
In order to protect the enƟre informaƟon chain, today more than ever, there is a large need for
pervasive security, which is the right security, in the right place at the right Ɵme.
Such a security deployment is neither easy nor impossible. However, a layered holisƟc security
approach must be taken, intertwining security technology, physical security, and logical or oper-
aƟonal security in the right parts of the informaƟon flow.
As a maƩer of fact, a so pervasive approach may be too challenging for both developers and final
users, unless a proper abstracƟon level is provided. A methodology is thus required to efficiently
implement holisƟc security on hardware and soŌware security systems, which too many Ɵmes
are underesƟmate or ignored when a security soluƟon is deployed.
Although soŌware gives easy and flexible protecƟon, hardware is much faster and provides beƩer
immunity from contaminaƟon, malicious code infecƟons or vulnerability.
Hardware-based encrypƟon offers stronger resilience against many common aƩacks. This is even
more effecƟve when heterogeneous technologies are integrated in a unique embedded plaƞorm.
In this case the complexity of possible cyber-aƩacks grows up drasƟcally and there are several
hardware techniques to enforce the system, like hardware anƟ-tampering, redundancy, fault-
detecƟon, etc.
Nevertheless, such a complex plaƞorm also increases the development complexity, requiring
to combine and harmonise different technologies in a seamless way. There are a few security-
oriented open plaƞorms available on the market. Some of them are focused on the evaluaƟon of
the system robustness against external physical aƩacks (e.g., Side-Channel aƩacks, power crypto-
analysis, etc.), such as the Sasebo board1 and the ChipWhisperer2. Other plaƞorms based onARM
processors, like Juno ARM Development Plaƞorm3 and the open source USB device provided by
InversePath4, allow creaƟng general purpose soŌware applicaƟons, including security-oriented
soluƟons. Nevertheless, they are based on applicaƟon processors and there are not specific se-
curity elements to be fully controlled or customized by the developers. Finally, there are single
1Toppan Ltd, “Side-channel AƩack Standard EvaluaƟon Board: SASEBO”, http://www.toptdc.com/en/product/
sasebo/

2C. O’Flynn, and D. C. Zhizhang. ”ChipWhisperer: An open-source plaƞorm for hardware embedded security re-
search.” In: ConstrucƟve Side-Channel Analysis and Secure Design. Springer InternaƟonal Publishing, 2014. 243-
260

3Arm LTD, “Juno ARM Development Plaƞorm”, http://www.arm.com/products/tools/development-boards/
versatile-express/juno-arm-development-platform.php

4Inverse Path Srl, “USB Armory”, https://inversepath.com/usbarmory.html

http://www.toptdc.com/en/product/sasebo/
http://www.toptdc.com/en/product/sasebo/
http://www.arm.com/products/tools/development-boards/versatile-express/juno-arm-development-platform.php
http://www.arm.com/products/tools/development-boards/versatile-express/juno-arm-development-platform.php
https://inversepath.com/usbarmory.html
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chips realized as a combinaƟon of one FPGA and one CPU, like Zynq proposed by Xilinx5 or Excal-
ibur based on Altera technology6. Nevertheless, in both the cases the plaƞorms aremore suitable
at prototyping stage, since they are not cost-efficient, and a specialized security element, like a
smart card, is sƟll missing.
In addiƟon, although in the last twenty-five years many abstracƟon layers and interfaces have
been proposed to integrate hardware security tokens in general purpose systems, the provided
funcƟons are typically limited to the low-level encrypƟon operaƟonswithout giving a real abstrac-
Ɵon level independent of the single cryptographic operaƟon.
For example, the PKCS#11 interface7 available since 1994 and sƟll largely used in the public-private
key based security infrastructures, provides over 50 funcƟons to deal with cryptographic algo-
rithms. Nevertheless, the cryptographic algorithms are treated with specific interfaces depend-
ing on their nature (e.g., digest, encrypƟon, key generaƟon, etc.). At the same way, MicrosoŌ
CSPs (Cryptographic Service Providers) defines several proprietary cryptographic packages with
specific interfaces according to the security provider. In any case, there are not abstracƟon layers
providing a service-oriented set of security funcƟonaliƟes implemented on complex and hetero-
geneous HW/SW security plaƞorms.

1.2 The SEcube™ Open Security Plaƞorm Project

On the basis of the above consideraƟons, in 2015 Blu5 Group8 involved several Academic in-
sƟtuƟons in launching the SEcube™ Open Security Plaƞorm: an open source security-oriented
hardware and soŌware plaƞorm, designed and constructed with ease of integraƟon and holisƟc
security in mind.
SEcube™ introduces a new approach to provide hardware and soŌware holisƟc security through
abstracƟon layers, each based on less than 10 APIs, which try to hide classical security concepts
like cryptographic algorithms and keys focusing, instead, on common operaƟonal security con-
cepts like groups and policies.
The Plaƞorm is centered on SEcube™ (Secure Environment cube): a security-oriented 3D SiP (Sys-
tem in Package) designed and produced by Blu5 Group. It integrates three key security elements
in a single package: a fast floaƟng-point Cortex-M4 CPU, a high-performance FPGA, and an EAL5+
cerƟfied SmartCard (Figure 1).

Figure 1: The 3 components of SEcube™ .

5L. H. CrockeƩ, R. A. Elliot, M. A, Enderwitz, and R. W. Stewart: The Zynq Book: Embedded Processing with the Arm
Cortex-A9 on the Xilinx Zynq-7000 All Programmable Soc. Strathclyde Ac. Media, 2014

6Altera CorportaƟon, “Excalibur Devices”, https://www.altera.com/products/general/devices/arm/arm-index.html
7Clulow, J. (2003, September). On the security of PKCS# 11. In InternaƟonal Workshop on Cryptographic Hardware
and Embedded Systems (pp. 411-425). Springer Berlin Heidelberg.

8www.blu5group.com

https://www.altera.com/products/general/devices/arm/arm-index.html
www.blu5group.com
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1.2.1 Project evoluƟon

The project currently involves the following insƟtuƟons:

• Blu5 Labs Ltd, Blu5 Group, Ta Xbiex, Malta –
Reference: Antonio VARRIALE, av@blu5labs.eu

• CINI Cybersecurity NaƟonal Lab (Politecnico di Torino Node), Torino, Italy –
Reference: Paolo PRINETTO, paolo.prineƩo@polito.it

• LIRMM, CNRS, Montpellier, France –
Reference: Giorgio DI NATALE, giorgio.dinatale@lirmm.fr

In 2017, the SEcube™ plaƞorm has been selected as the Open Security Plaƞorm for the project
FilieraSicura: Securing the Supply Chain of DomesƟc CriƟcal Infrastructures from Cyber AƩacks9,
supported by CINI Cybersecurity NaƟonal Laboratory and funded by CISCO Systems Inc.
Within such a project, the SEcube™plaƞorm is currently used to protect, among the others,Water
Supply Systems, Robots and ExoSkeletons of healthcare, IoT applicaƟons, and IP protecƟon in
industrial machines.

1.3 The Hardware side of the plaƞorm

The hardware side of the plaƞorm relies on the SEcube™Hardware device family, which comprise
a complete chain of devices, from chip to PCIexpress Board, and namely (Figure 2):

1. The Chip, named SEcube™ Chip, or simply SEcube™

2. The Development Board, named SEcube™ DevKit

3. The SƟck, named USEcube™ SƟck

4. The Phone, named SEcube™ Phone

5. The PCIexpress Board, named SEcube™ PCIe.

Figure 2: The SEcube™ Hardware device Family.

1.4 The SoŌware Architecture of the plaƞorm

The SEcube™ Open Source SoŌware Architecture is structured in several AbstracƟon Layers, as
summarized in Figure 3, usually referred to as L0, L1, L2, L3, and ApplicaƟons, respecƟvely. At
each AbstracƟon Layer, several sets of APIs are provided.
At each level, each component (but the lowest one) represents a “service” for the upper level and
9www.filierasicura.it

www.filierasicura.it
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relies on “services” provided by lower levels.
The SEcube™ -Side APIs are executed on the embedded processor of the SEcube™ -based hard-
ware device (e.g., the USEcube™ ), whereas at the External-Side, the soŌware is tailored for exist-
ing devices (e.g., laptops or Desktop PC) that see the SEcube™ hardware as an external peripheral
which exposes the SEcube™ -Side APIs. In this scenario, SEcube™ acts as a powerful coprocessor
providing a secure and fully controlled execuƟon environment.
The External-Side Libraries are designed to be scalable, i.e., for dealing with mulƟple devices,
and portable on different OperaƟng Systems, thus limiƟng the usage of and isolaƟng plaƞorm-
dependent modules. They pracƟcally run on top of the host OS, directly relying on the OS System
calls. To improve portability and migraƟons, the libraries are organized in such a way that all the
OS-dependent sub-modules (e.g., communicaƟon interface, file system, etc.) be easily idenƟfi-
able.
All the soŌware is released in source code under GPLv3 license10.

Figure 3: The SEcube™ SoŌware Architecture.

1.5 The SEcube™ Assets

In the sequel we shall focused on some of the most relevant SEcube™ assets.

1.5.1 State-of-the-Art Technology in your hands

SEcube™ provides the most advanced security hardware technologies in one chip. Being open,
both the hardware and the soŌware parts are completely disclosed and documented.

10https://www.gnu.org/licenses/gpl-3.0.en.html

https://www.gnu.org/licenses/gpl-3.0.en.html
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1.5.2 HolisƟc Security

Within SEcube™ , all the digital and organizaƟonal security processes are integrated in a compre-
hensive, flexible, and seamless way. No need for developers to look at the single building parts.
MathemaƟcal and cryptographic elements, like keys and algorithms, are replaced by simpler con-
cepts, like groups and policies (cfr. SecƟon 2).

1.5.3 MulƟ-Flavor and MulƟ-Level Libraries

Leveraging on three embedded technologies, the same API can be executed on different cores
(STM32, FPGA, Smart Card). The APIs are organized in modular libraries and abstracƟon layers.
Developers are open to create their soluƟon starƟng from themost suitable entry point according
to their experƟse. SEcube™ is ready to transform your security ideas to security products. StarƟng
from the Open Source SoŌware Architecture, programmers can easily create, verify and deploy
their security soluƟons on SEcube™ -based professional devices and appliances.

1.5.4 Work CompartmentaƟon for Limited LiabiliƟes

The SEcube™security architecture allows role separaƟon (Developer, Security Administrator, Users)
for work opƟmizaƟon by competence. The same architecture allows protecƟng all the producƟon
and deployment chain players (Factory, OEMs, Final Customers) isolaƟng their respecƟve roles
and liabiliƟes.

1.5.5 Pre-Built FuncƟonaliƟes

Basic and standard security modules are ready for use to save up Ɵme and resources. In addiƟon,
security experts can verify, improve and extend the SEcube™ funcƟonaliƟes working on the open
source code.

1.5.6 Full CustomizaƟon

StarƟng from the modular and reusable funcƟons, developers are able to reinvent the basic se-
curity blocks for new fully customized and controlled security systems.

1.6 The SEcube™ Entry Points: How using SEcube™ ?

Leveraging the libraries and applicaƟons that are freely available to download from the Internet,
you are provided with both low-level (i.e., firmware and middleware to interact at low level with
the hardware) and high-level (i.e., fully fledged ready-to-use applicaƟons to secure your data and
communicaƟons) entry points to the SEcube™ Open Source Security Plaƞorm.

1.7 The SEcube™ Community

Leveraging the plaƞorm thought, we intend to create and nurture over Ɵme a community for
developers at the different levels of security competence and in different applicaƟon domains.
This will ease sharing project, knowledge, and resource and provide the collecƟvity of members
with specialized support tailored to their needs.

1.8 The SEcube™ Academia Program

Academic InsƟtuƟons and Research Centers interested in using the SEcube™Open Source Security
Plaƞorm and Devices in
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• Courses and Thesis

• Summer Schools

• Funded Projects

• ConsulƟng AcƟviƟes

• Hackatons and CompeƟƟons

can apply for a dedicated Program offered by Blu5 Group and receive the following benefits:

• Discounts on SEcube™ DevKit and Devices

• Free Basic Technological Trainings for Academics

• PotenƟal involvement in Industrial and Market-Driven projects and acƟviƟes

The SEcube™ Academia Program is completely FREE.
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2 HolisƟc Security

A security system becomes appealing when both developers and users are not aware of its com-
plexity. This result can be definiƟvely reached when all the digital and organizaƟonal security
processes are integrated in a comprehensive, flexible and seamless way.
This approach is called holisƟc security. Users and developers are not required to look at the sin-
gle building parts. They can rather focus on using the system complexity without taking care of it.
On these principles, the security system should be realized keeping in mind that classical security-
related concepts like cryptographic algorithms andencrypƟon keys should slowly disappear among
the hardware and soŌware abstracƟon layers provided by the designers.
Although sooner or later informaƟonmust be secured with cryptographic techniques, the related
complexity (e.g., mathemaƟcs, staƟsƟcs, security paradigms, implementaƟons) can be demanded
to security experts, which oversee provisioning and maintaining the system, whilst users and ap-
plicaƟon developers can be just focused on the final security service.
InformaƟon can typically be in two major statuses: at rest and in moƟon. In both cases the most
important and intuiƟve quesƟon to be considered when protecƟng data is the following: what
recipient should informaƟon be protected for? Usually there are three possible answers:

• InformaƟon protected for yourself (Personal Security)

• InformaƟon protected for a group of people (Group Security)

• InformaƟon protected for anybody sharing the same security plaƞorm (Family Security).

On this assumpƟon, the security can be applied to the informaƟon independently from the kind
of secure service we are targeƟng. For example, secure services like secure data bases, secure file
repositories, secure galleries, securewallets, etc. can beprotected bymeans of the SEfile™holisƟc
library (cfr. SecƟon 6), since this is the case of data at rest protecƟon. For services like secure voice
calls, securemessaging, secure client-server web applicaƟons, etc. the SElink™holisƟc library (cfr.
SecƟon 7) can be used, since we are in the case of data in moƟon protecƟon.
Security services based on the holisƟc security approach, can be also developed without taking
care of cryptography, hardware/soŌware implementaƟons or any other architectural complexity.
Concepts like closed communicaƟon / protecƟon groups and security policies can easily replace
keys, algorithms, and cryptographic parameters.

2.1 Secure CommunicaƟon/ProtecƟon Groups

A Secure CommunicaƟon/ProtecƟon Group is a pool of one or more users. Each group is featured
by a group key and a set of security policies, both shared by ALL the members of the group.
The group key is used to protect both staƟc data (data at rest) and data transfers (data in moƟon)
among the members of the group. In parƟcular, the key is usually used, in the former case, to
derive “secrets” (or “seeds”) used by cryptographic algorithms, and, in the laƩer one, to set up
secure communicaƟon channels.
The security policies allow specifying, among the others, the cryptographic algorithm used to
protect the informaƟon related to that group and the mechanism to be adopted for generaƟng
the session keys.

2.2 Centralized vs. Distributed security infrastructures

In managed security infrastructures, also called centralized security infrastructures, users are
grouped in secure groups by a security administrator that operates on a KeyManagement System
(KMS).
The KMS is an extremely important part of the security infrastructure, since it is enƟtled to:
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• Provision/IniƟalize all the security elements (e.g., USB tokens, etc.);

• Create and populate CommunicaƟon/ProtecƟon groups;

• Refresh and distribute the communicaƟon/protecƟon keys and policies

within the security infrastructure.
In distributed security infrastructures, i.e., in security infrastructures not managed by a central-
ized system, any user can be administrator of one or more communicaƟon / protecƟon groups.
It is strongly recommended not to have more than one administrator per group, to respect the
responsibility paradigm: in case of disputes, the responsible should be univocally idenƟfied.
In any case, for both centralized and distributed security infrastructures, the concepts of groups
and policies can be applied instead of keys, cryptographic algorithms, etc.
On the funcƟonal side, both the developers and the users just see groups. They are not required
to knowwhich algorithms or keys are behind each group. The security administratorwill associate
keys and algorithms to any group and populate them with users according to the organizaƟon se-
curity policies.
It is easy to understand that two or more users can access the informaƟon only if they share at
least one group. Of course, users are allowed to create sub-groups, within the security perimeter
defined by the administrator.
In this way, at the applicaƟon level it is not required to specify any kind of encrypƟon method or
cryptographic keys. As described in (cfr. SecƟon 6) and (cfr. SecƟon 7) by means of data at rest
and data in moƟon protecƟon libraries, it is possible to reach a very high security abstracƟon level
through a small set of APIs that are easy to be integrated in the final service.
As a maƩer of fact, this approach isolates the cryptographic funcƟonality from the security ser-
vice. Nevertheless, another abstracƟon layer is required to isolate the cryptographic funcƟonali-
Ɵes from their implementaƟons, which may rely on different technologies (e.g., CPU, FPGA, and
SmartCard).
The combinaƟon of a proper soŌware architecture, which provides intuiƟve security at applica-
Ɵon level, and a seamless cryptographic framework, which harmonizes different implementaƟons
in a unique object-oriented interface, allows to design a real holisƟc security system on top of a
complex HW/SW plaƞorm like SEcube™ .
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3 The Hardware side of the Plaƞorm

3.1 The SEcube™ Chip

The core of the SEcube™ Hardware device family is a 3D SiP (System in Package) (a detail is in
Figure 4), integrated in a 9mm x 9mm BGA package (Figure 5). The full SEcube™ Data Sheet is
available in Appendix A11.

Figure 4: Detail of the die of the SEcube™ Chip

Figure 5: The SEcube™ Chip

The single chip embeds three hardware components: a powerful processor, a flexible FPGA, and
an EAL5+ cerƟfied smart card.
11cfr. https://www.secube.eu/site/assets/files/1145/secube_datasheet_-_r7.pdf

https://www.secube.eu/site/assets/files/1145/secube_datasheet_-_r7.pdf
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3.1.1 The Processor

The processor adopted within the SEcube™ is the STM32F429, produced by ST Microelectron-
ics™ 12, which includes a high-performance ARM Cortex M4 RISC core and provides the following
features:

• 2 MiB13 of Flash memory

• 256 KiB of SRAM

• 32-bit parallelism

• OperaƟng frequency of 180 MHz

• Low power consumpƟon.

This CPU has been selected among many ARM-based microcontrollers, since it offers several fea-
tures that make it suitable for high-performance and security-oriented soluƟons. For example,
it supports the Cortex CMSIS implementaƟon that provides, among the others, the CMSIS-DSP
libraries: a collecƟon with over 60 DSP funcƟons for various data types. The CMSIS-DSP library
allows developers to implement complex, real Ɵme operaƟons using the embedded hardware
FloaƟng Point Unit.
In addiƟon, the CPU provides several peripherals such as SPI, UART, USB2.0 and SD/MMC, which
ease the hardware integraƟon in diverse devices. For example, a secure USB device can be easily
realized using the USB2.0 and the SD card interfaces, respecƟvely.
On the security side, a TRNG (True Random Noise Generator) embedded unit, hardware mecha-
nisms like MPU (Memory ProtecƟon Unit), and privileged execuƟon modes allow implemenƟng
the security strategies required by a cerƟfied secure controller (e.g., privileged memory areas,
key generaƟon, etc.).
For programming, debug, and tesƟng operaƟons, the CPU provides a standard JTAG interface that
can be permanently disabled once the development cycle is over, protecƟng all the sensiƟve in-
formaƟon through a physical hardware lock.

3.1.2 The FPGA

The FPGA element, a Laƫce MachXO2-7000 device14, is based on a fast, non-volaƟle logic array
providing the following main features:

• 7,000 LUTs

• 240 Kib embedded block RAM

• 256 Kib user flash memory

• Ultra low-power device.

12http://www.st.com/en/microcontrollers/stm32f4-series.html?querycriteria=productId=SS1577
13For this document:

– 1 KiB = 210 Bytes

– 1 MiB = 220 Bytes

– 1 GiB = 230 Bytes

14http://www.latticesemi.com/view_document?document_id=38834

http://www.st.com/en/microcontrollers/stm32f4-series.html?querycriteria=productId=SS1577
http://www.latticesemi.com/view_document?document_id=38834
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The FPGA exposes 47 general-purpose I/Os which may be used as a 32-bit external bus able to
transfer data at 3.2 Gib/s.
As outlined in Figure 6, within the SEcube™ Chip the FPGA is connected to the CPU through a
16-bit internal bus, providing a data transfer rate of up to 1.6 Gib/s.
A CPU-FPGA clock line is provided to simplify the clock domains synchronizaƟon.
To limit the number of pins and the BGA package size, the FPGA JTAG is connected just to the
embedded CPU, which manages both the debug and the programming operaƟons. Therefore,
the FPGA configuraƟon can be implemented by means of customized, high-security techniques.
For example, the programming bitstream can be encrypted and signed through dedicated algo-
rithms. The CPU and/or the smartcard elements can then be used to decrypt and verify it before
its injecƟon into the FPGA.

3.1.3 The SmartCard

The third component of the SEcube™ Chip is an EAL5+ cerƟfied security controller, hereaŌer
named smartcard15, based on a secure chip produced by Infineon, that provides the following
features:

• ISO7816 interface

• JavaCard Plaƞorm, Global Plaƞorm 2.2

• 128 KiB Flash

• EC, ECDH up to 521 bit (HW accelerator)

• RSA up to 2 Kib (HW accelerator)

• AES128/192/256 (HW accelerator).

As outlined in Figure 6, within the SEcube™ Chip, the SmartCard is connected to the CPU via a
standard ISO7816 interface.
The smartcard does not expose any interface outside the chip. This architectural soluƟon provides
high-grade and cerƟfied security funcƟonaliƟes behind a simpler and easy-to-use applicaƟon in-
terface.

15Infineon Chip Card & Security ICs Porƞolio
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3.1.4 On-chip connecƟons

The Figure 6 summarizes the interconnecƟons between the three components of SEcube™ and
their interfaces with the external.

Figure 6: The SEcube™ Hardware Architecture.

3.2 The SEcube™ Devkit

The SEcube™ DevKit is an open development board (Figure 7) designed to support developers to
integrate the SEcube™ Chip in their hardware and soŌware projects.

Figure 7: The SEcube™ DevKit.

A floor planning view of the board is in Figure 8, whereas schemaƟc can be found in Appendix B.
The board is equipped with several interfaces and peripherals, including:
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• USB 2.0 High Speed (J5000)

• USB 2.0 to UART (J1000)

• microSD card (J4002)

• Ethernet 10/100 socket (J2000)

• Switches and Led (SW4000, SW4001, SW3000, LED0, …)

• SEcube™ embedded FPGA and CPU GPIOs (J4004, J4000)

• SEcube™ embedded CPU JTAG (J4001).

Figure 8: Floor planning view of the SEcube™ DevKit.

The board is directly powered by one of the 2 micro USB connectors. The jumper 3002 selects
the connector to be used to power the board (pins 1-2 select J5000, pins 2-3 select J1000). The
SEcube™ DevKit allows connecƟng two power supply lines and measuring the related power con-
sumpƟon, through the following jumpers:

• J3000: 1V2 power supply line

• J3001: 3V3 power supply line.

The power supply of the SmartCard embedded into SEcube™ is controlled by a dedicated pin.
Nevertheless, the jumper J4005 allows to bypass this control and power the embedded smartcard
permanently.
The jumper J4003 allows a direct control of the SEcube™ reset pin via the JTAG interface.
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3.2.1 How to get it

The SEcube™ DevKit can be ordered online16.
Your purchase should comprise the following items (Figure 34):

• The SEcube™ DevKit

• USB 2.0 A to Mini-B cable.

Figure 9: Components purchased with the SEcube™ DevKit.

3.3 The USEcube™ SƟck

As shown in Figure 10, the USEcube™ SƟck is an USB form factor based on the SEcube™ Chip,
which proves to be an amazing way to deploy the SEcube funcƟonaliƟes through a USB 2.0 High-
Speed interface.

Figure 10: The USEcube™ SƟck.

From the hardware point of view, the USEcube™ SƟck is designed as part of the SEcube™ DevKit.
This allows the developers to migrate in a very fast way from the development board to the SƟck
and be ready for a market deployment.
TheUSEcube™ SƟck is compaƟble with any OperaƟng System and the SEcube™ funcƟonaliƟes are
easily exposed to applicaƟons and services without installing any driver.
Since the USEcube™ SƟck storage capability is based on a microSD card, both the size and the
speed can be tuned per the user requirement and can be changed at any Ɵme, just replacing the
16www.secube.eu

www.secube.eu
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microSD, without buying a new USEcube™ SƟck.
The microSD card socket is embedded in the USB connector. As shown in Figure 11, this soluƟon
allows to save space making the USEcube™ SƟck very compact and, at the same Ɵme dust and
water-resistant.
Since theUSEcube™SƟck is not providedwith the JTAG interface, to inject the firmware previously
developed and tested on the USEcube™ DevKit, all the devices come with an embedded secure
boot loader.

Figure 11: USEcube™ SƟck internal structural details.

Figure 12: The USEcube™ SƟck plugged into a laptop.

3.3.1 How to get it

The USEcube™ SƟck can be ordered online17.
Your purchase should comprise various items, depending on which purchase opƟon you choose.

17www.secube.eu

www.secube.eu
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4 The SoŌware Architecture of the Plaƞorm

The SEcube™ Open Source SoŌware Architecture is structured in several AbstracƟon Layers, as
summarized in Figure: 13, usually referred to as L0, L1, L2, L3, and ApplicaƟons, respecƟvely. At
each AbstracƟon Layer, several sets of APIs are provided. At each level, each component (but
the lowest one) represents a “service” for the upper level and relies on “services” provided by
lower levels. The SEcube™ -Side APIs are executed on the embedded processor of the SEcube™ -
based hardware device (e.g., theUSEcube™ ), whereas at the External-Side the soŌware is tailored
for exisƟng devices (e.g., laptops or Desktop PC) that see the SEcube™ hardware as an external
peripheral which exposes the SEcube™ -Side APIs. In this scenario, SEcube™ acts as a powerful
coprocessor providing a secure and fully controlled execuƟon environment. The External-Side
Libraries are designed to be scalable, i.e., for dealing with mulƟple devices, and portable on dif-
ferent OperaƟng Systems, thus limiƟng the usage of and isolaƟng plaƞorm-dependent modules.
They pracƟcally run on top of the host OS, directly relying on the OS System calls. To improve
portability and migraƟons, the libraries are organized in such a way that all the OS-dependent
sub-modules (e.g., communicaƟon interface, file system, etc.) be easily idenƟfiable. All the soŌ-
ware is released in source code under GPLv3 license18.

Figure 13: SoŌware Architecture of SEcube™ .

18https://www.gnu.org/licenses/gpl-3.0.en.html

https://www.gnu.org/licenses/gpl-3.0.en.html
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4.1 Device-Side Libraries

In this secƟon are presented some of the principal Device-Side APIs, a more in depth explanaƟon
and the full list of the APIs can be found in the SDK package available online19.

4.1.1 SEcube™ Core

uint16_t echo(uint16_t req_size, const uint8_t* req, uint16_t*
resp_size, uint8_t* resp)

It is the device-side API to post back any data it receives.

uint16_t factory_init(uint16_t req_size, const uint8_t* req,
uint16_t* resp_size, uint8_t* resp)

It is the device-side API to iniƟalize the device as well its serial number; the device remains locked
unless the funcƟon answers correctly to a security challenge.
4.1.2 Dispatcher Core

uint16_t key_edit(uint16_t req_size, const uint8_t* req,
uint16_t* resp_size, uint8_t* resp)

Insert, delete or update a key on the device.

uint16_t key_list(uint16_t req_size, const uint8_t* req,
uint16_t* resp_size, uint8_t* resp)

Get a list of keys in the device.

uint16_t challenge(uint16_t req_size, const uint8_t* req,
uint16_t* resp_size, uint8_t* resp)

Get a login challenge from the device.

uint16_t login(uint16_t req_size, const uint8_t* req, uint16_t*
resp_size, uint8_t* resp)

Respond to challenge and complete the login.

uint16_t logout(uint16_t req_size, const uint8_t* req, uint16_t*
resp_size, uint8_t* resp)

Log our and release resources.
4.1.3 CommunicaƟon Core

int32_t se3_proto_recv(uint8_t lun, const uint8_t* buf, uint32_t
blk_addr, uint16_t blk_len)

This funcƟon is called when some request to the SEcube™ arrive from the Host side.

int32_t se3_proto_send(uint8_t lun, uint8_t* buf, uint32_t
blk_addr, uint16_t blk_len)

This funcƟon is called when the SEcube™ respond to the previous Host request.
4.1.4 Smart Card Driver

This set of funcƟonaliƟes shall provides all the APIs necessary for interacƟng whit the SmartCard.
It is sƟll to be implemented.

19https://www.secube.eu/resources/open-sources-sdk/

https://www.secube.eu/resources/open-sources-sdk/
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4.1.5 Security Core

uint16_t crypto_init(uint16_t req_size, const uint8_t* req,
uint16_t* resp_size, uint8_t* resp)

IniƟalize a cryptographic context.

uint16_t crypto_update(uint16_t req_size, const uint8_t* req,
uint16_t* resp_size, uint8_t* resp)

Use a cryptographic context.

uint16_t crypto_set_time(uint16_t req_size, const uint8_t* req,
uint16_t* resp_size, uint8_t* resp)

Set device Ɵme for key validity.

uint16_t crypto_list(uint16_t req_size, const uint8_t* req,
uint16_t* resp_size, uint8_t* resp)

Get a list of available algorithms implemented on the device.
4.1.6 SD Card Driver

This driver provides all the funcƟonaliƟes required for communicaƟngwith the SD Card connected
to the SEcube™ .

4.1.7 USB Driver

This driver provides all the funcƟonaliƟes required for interacƟng with the USB connecƟon. The
SEcube™ needs to know when something have been wriƩen through the USB connecƟon (on the
SD Card) in order to check if it is a request from the Host or other type of data.

4.1.8 SEkey

This library contains the implementaƟonof theAPIs required to interactwith SEkey™ formanaging
keys and groups. These APIs are sƟll to be implemented.

4.1.9 Time Core

The set of APIs in this core implements the funcƟonaliƟes required for managing the Ɵme on the
SEcube™ device, such as reading the current Ɵme, using Ɵmers, etc.

4.2 Host-Side Libraries

4.2.1 L0 Libraries

This level implements the basic funcƟonaliƟes to communicate with the SEcube™ device. This
layer mainly includes 3 families of APIs:

• Provisioning APIs

• CommunicaƟon APIs

• CommodiƟes APis

The performed funcƟonaliƟes include, among the others:

• sending/receiving command and data packets from/to the device
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• segmenƟng raw data streams into protocol-compliant packets

• low-level error management

• low-level data manipulaƟon in dealing with possible endianness mismatches between the
host side and the SEcube™ embedded processor.

Provisioning APIs

uint16_t L0FactoryInit(const uint8_t* serialno)

It is used to iniƟalize the device as well as its serial number; the device remains locked unless it
has been iniƟalized. This service must be called before using the SEcube™ device to set up its en-
vironment properly. This service can be called just once, as the device cannot be iniƟalized more
than once.

CommunicaƟons APIs

void L0Open()

It opens the communicaƟon with the SEcube™ device.

void L0Close()

It closes the communicaƟon with the SEcube™ device.

void L0TXRX(uint16_t reqCmd, uint16_t reqCmdFlags, uint16_t
reqLen, const uint8_t* reqData, uint16_t* respStatus,
uint16_t* respLen, uint8_t* respData)

It is the main funcƟon for communicaƟng with the SEcube™ device. It send a packet of data
containing a command and the relaƟve parameters and then reads back the response wriƩen by
the SEcube™ in a shared data buffer.

uint16_t L0Echo(const uint8_t* dataIn, uint16_t dataInLen,
uint8_t* dataOut)

It is the host-side API to send a packet of data to the device, which should then reply with the
same data. Login is not required to communicate with the device via the echo service.
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CommodiƟes APIs
To exploit the security funcƟonaliƟes exposed by the SEcube™ device, the Host must:

• Discover whether at least a valid and iniƟalized device is plugged

• Choice the desired device among a list if more than just one device is plugged

• Discover the serial number of the desired device.

To implement the discovery funcƟonality, the L0 service leverages on iterators, objects that en-
ables a programmer to traverse a container, parƟcularly lists.

void L0DiscoverInit()

It is the host-side API to iniƟalize the iterator object to traverse a list of SEcube™ devices.

bool L0DiscoverNext()

It is used to traverse the list, moving the iterator object anyƟme towards the following element
to the list.

4.2.2 L1 Libraries

This level relies on L0 APIs to provide the basic APIs for implemenƟng secure applicaƟons, includ-
ing mulƟ-factor login, secure communicaƟon channel, cryptographic algorithms, and key man-
agement. The services exposed at this level includes several APIs to manage:

• login/logout

• security
– key management
– cryptography

In addiƟon, L1 allows developers to manage several SEcube™ devices concurrently, providing
dedicated operaƟon control flows (one command/response session per communicaƟon channel),
which allow encoding and decoding commands for the individual SEcube™ target.

Login/Logout APIs

void L1Login(const uint8_t* pin, uint16_t access, bool force)

It is used to iniƟalize the procedures needed to login to the device. This service is used to let the
user, or the admin, login on the SEcube™ device. Before issuing any command to the SEcube™ ,
apart from the Echo command, login is required. Please note that default user and admin PIN are
set to all zeroes.

bool L1GetSessionLoggedIn()

It is used to check whether the login has been executed (returns true) or not (returns false).

se3_access_type L1GetAccessType()

It is used to check the access privilege to the SEcube™ (i.e. admin privilege or user privilege) aŌer
the login to the device.

void L1Logout()

It is used to iniƟalize the procedures needed to logout from the device.

void L1LogoutForced()

It allows to force the logout from the device.
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Security APIs

void L1CryptoSetTime(uint32_t devTime)

It is used to set expiraƟon date for a cryptographic context.
WARNING: This funcƟon must be invoked right aŌer any login operaƟon, otherwise all of the
subsequent operaƟons cyphering will fail.

void L1CryptoInit(uint16_t algorithm, uint16_t mode, uint32_t
keyId, uint32_t* sessId)

It is used to iniƟalize a cryptographic context.
WARNING: data length for input and output must be a mulƟple of the crypto block size. The
length of the input buffer is computed with the macro ENC_SIZE(buffer_len). The output buffer
is allocated with that length but the actual length is an output of the funcƟon.

void L1CryptoUpdate(uint32_t sessId, uint16_t flags, uint16_t
data1Len, uint8_t* data1, uint16_t data2Len, uint8_t* data2,
uint16_t* dataOutLen, uint8_t* dataOut)

It is used to update a cryptographic context.
WARNING: data length for input and output must be a mulƟple of the crypto block size. The
length of the input buffer is computed with the macro ENC_SIZE(buffer_len). The output buffer
is allocated with that length but the actual length is an output of the funcƟon.

void L1Encrypt(size_t dataInLen, uint8_t* dataIn, size_t*
dataOutLen, uint8_t* dataOut, uint16_t algorithm, uint16_t
mode, uint32_t keyId)

It is used to encrypt a buffer of data given the algorithm, the encrypƟon mode, and the buffer
size; data encrypted are then retrieved and returned as outcome.

void L1Decrypt(size_t dataInLen, uint8_t* dataIn, size_t*
dataOutLen, uint8_t* dataOut, uint16_t algorithm, uint16_t
mode, uint32_t keyId)

It is used to decrypt a buffer of data given the algorithm, the decrypƟon mode, and the buffer
size; data encrypted are then retrieved and returned as outcome.

void L1Digest(size_t dataInLen, uint8_t* dataIn, size_t*
dataOutLen, uint8_t* dataOut, uint16_t algorithm)

It is used to compute the digest of a data buffer given the algorithm, and the buffer size; the digest
is used to sign the data buffer.

void L1GetAlgorithms(uint16_t maxAlgorithms, uint16_t skip,
se3Algo* algorithmsArray, uint16_t* count)

It is used to retrieve the list of the security algorithms supported by the device.

void L1SetAdminPIN(uint8_t* pin)

It is used to change the current admin pin.

void L1SetUserPIN(uint8_t* pin)

It is used to change the current user pin.

void L1KeyEdit(se3Key* k, uint16_t op)

It is used to update a security key inserted into the device and its cryptographic context, in terms
of adding, ediƟng or removing it.
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void L1KeyList(uint16_t maxKeys, uint16_t skip, se3Key* keyArray
, uint16_t* count)

It is used to retrieve the list of the security keys inserted into the device and its cryptographic
context.

bool L1FindKey(uint32_t keyId)

It is used to find a security key if it is inserted into the device and its cryptographic context.

4.2.3 L2 Libraries

This level relies on L1 APIs to provide a set of APIs for implemenƟng secure funcƟonaliƟes at
a higher level of abstracƟon. In parƟcular, L2 APIs offer opƟmized and easy-to-use funcƟonali-
Ɵes to ease the development of applicaƟons that create and manage enƟƟes that are fully pro-
tected (i.e., authenƟcated and confidenƟal), without being forced to understand in details all
the low-level hardware and security mechanisms. The provided APIs include a Key Management
System (SEkey™ ), a data-at-rest protecƟon facility (SEfile™ ), and a data-at-moƟon protecƟon fa-
cility (SElink™ ), briefly outlined in the sequel. Conceptually, APIs belonging to the L2 abstracƟon
layer expose funcƟonaliƟes needed for any user who wants to perform, bymoving inside a secure
environment, basic operaƟons on regular files and network packages. The concept of a secure
environment reflects the need of providing a simple mechanism to allow the user to customize
the parameters of the secure session, by configuring the keys to be used, and the algorithms to
be enforced through all the valid life of the session itself.

4.3 SEfile™

Any OS provides an abstracƟon layer in its kernel space, used to separate file system generic oper-
aƟons from their implementaƟon. This is performed by defining a clean Virtual File System (VFS)
interface. Several implementaƟons for the VFS interface may coexist on the same machine, al-
lowing transparent access to different types of file systems mounted locally. Data protecƟon is
provided at this level of abstracƟon, bymeans of a dedicated security engine, hereinaŌer referred
to as secure layer. However, malicious user, or soŌware, sƟll may exploit exisƟng flaws in the ap-
plicaƟon accessing to the secure layer or even in the secure layer itself to steal and compromise
private informaƟon and confidenƟal data. A countermeasure to protect effecƟvely data, thus, re-
sorts to hardware key management techniques applied to powerful embedded systems that can
perform complex cryptographic operaƟons while, at the same Ɵme, increasing the confidence
of data security. A secure device can guarantee data protecƟon also when the host machine is
compromised. SEfile™ is a file system that exploits the hardware key management exposed from
L1 libraries (see 4.2.2) and other funcƟonaliƟes from the SEcube™ device. It has been developed
having in mind the needs to ensure both simplicity of usage and security for data at rest: it allows
secure storage, retrieve and usage of informaƟon that could not be trusted if stored elsewhere,
e.g., any personal computer, or cloud service provider. SEfile™ is deeply analyzed in Chapter 6.

4.4 SElink™

SElink™ is a soŌware applicaƟon that uses the SEcube™ open plaƞorm to secure the network traf-
fic. It can encrypt network streams originaƟng from any applicaƟon, regardless of the applicaƟon-
level protocol. SElink™ is a reference implementaƟon of an applicaƟon on top of the L1 APIs4.2.2
for SEcube™ . By using SElink™ it is possible to add a secure network layer to any soŌware, with-
out modifying its code base. In other words, the user can employ any of his/her favorite network-
enabled soŌware (e.g., web browser, remote desktop viewer) and entrust the customizable secu-
rity features to the SEcube™plaƞorm, in a way that is completely transparent to the user, allowing
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him to exploit the benefits of the security funcƟonaliƟes without having deep knowledge about
security. The network soŌware (i.e., browser, cloud service for data sharing, etc.) does not need
to be aware of the presence of SElink™ and will funcƟon as usual, because SElink™ intercepts
connecƟons at a lower level. SElink™ is deeply analyzed in Chapter 7.

4.5 SEkey™

SEkey™ is a library that is used to manage encrypƟon keys stored on the SEcube™ device. SEkey™
, therefore, is a simple KeyManagement System (KMS) that allows to handle the enƟre lifecycle of
encrypƟon key. The KMS offers a set of APIs that can be used to create and distribute encrypƟon
keys to several SEcube™ devices, each one belonging to a user of the KMS itself.
The users of SEkey™ are organized in groups, so that access to sensiƟve informaƟon and to en-
crypƟon keys can be granted with fine granularity, for example authorizing only a specific user or
a specific group of users. SEkey™ is completely handled by a single Security Administrator, whose
role is to manage the KMS generaƟng new keys, adding and removing users, creaƟng and modi-
fying groups and so on.
SEkey™ exploits other SEcube™ libraries (i.e. L1 and SEfile™ ) to keep the managed data as secure
as possible, for example storing them into an encrypted SQL database. In conclusion, SEkey™
implements a simple Key Management System that allows to any user, even without a solid cy-
bersecurity background, to handle the lifecycle of encrypƟon key without the need of worrying
about low level security details; this is done thanks to a broad range of simple APIs. SEkey™ is
deeply analyzed in Chapter 8.

4.6 L3 Libraries

This level relies on L2 services to develop secure applicaƟons, such as:

• Secure Virtualized File System

• Secure Data Base

• Secure Real-Ɵme Messaging

• ...
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5 ExploiƟng the internal FPGA

As already presented, among its hardware resources the SEcube™ offers a powerful flexible FPGA
by Laƫce Semiconductor.
The FPGA is assumed to be configured to include one or a set of IP Cores. Such cores implement
a set of funcƟons, as fast compuƟng of dedicated algorithms or enabling the device to expand its
interfacing capabiliƟes. Each core present onto the FPGA should have its own SW Driver included
in the SDK. The driver is in charge of the communicaƟon between the processor and the FPGA.

5.1 FPGA-CPU connecƟon

The processor and the FPGA within the SEcube™ plaƞorm are connected via a bus as depicted in
Figure 14.
The set of interconnecƟons is used for exchanging data, control, and status signals, including:

• Clock, reset and interrupt signals

• JTAG interface for programming the FPGA

• Other control lines

The configuraƟon within the SEcube™ treats the FPGA as an external memory device (PSRAM),
leveraging the Flexible Memory Controller (FMC) available on the processor. The FMC is an inter-
facing peripheral of the microcontroller used to connect external memories such as NOR Flash,
NAND Flash, SRAM, and PSRAM20, as in this case. With this configuraƟon, each pin assumes a
specific behaviour, its value and transiƟons being directly managed by the FMC.
The available pins within the bus are:

• Address – 6 pins (CPU_FPGA_BUS_A0:5)

• Data – 16 pins (CPU_FPGA_BUS_D0:15)

• Chip select – 2 pins (CPU_FPGA_BUS_NE1:2)

• Clock – 1 pin (CPU_FPGA_CLK)

• Controls – 2 pins (CPU_FPGA_{INT_N, RST})

• JTAG – 5 pins (CPU_FPGA_JTAG_{TDI, TDO, TMS, TCK}, CPU_FPGA_PROGRAMN).

20For addiƟonal details, please refer to STM32F405/415, STM32F407/417, STM32F427/437 and STM32F429/439
advanced Arm-based 32-bit MCUs Reference Manual, Chapter 37: https://www.st.com/content/ccc/resource/
technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/
jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116

https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=1602&zoom=100,0,116
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Figure 14: FPGA-CPU connecƟons within SEcube™

5.2 The Flexible Memory Controller

The Flexible Memory Controller (FMC) present on the STM32F429 processor is a useful block that
can be programmed to interface with an external memory. In the SEcube™ case, the FPGA can
be seen as a block of external PSRAM (Pseudo-StaƟc RAM), as already menƟoned. According
to the schemaƟc presented in the Reference Manual, the FMC disposes of the following PSRAM
interface:

• Address - 26 pins (FMC_A25:0)

• Data - 32 pins (FMC_D31:0)

• Bank Enable - 4 pins (FMC_NE1:4)

• Output Enable - 1 pin (FMC_NOE)

• Write Enable - 1 pin (FMC_NWE)

The Flexible Memory Controller is able to manage 4 different banks of memory within a specific
address range. Bits [27:26] of the AHB address bus (HADDR) are interpreted by the FMC as the
idenƟfier for 1 of the 4 banks, and enable the acƟvaƟon of the corresponding NEx signal (NE1,
NE2, NE3 or NE4), which is acƟve low. Bits [25:0] of the same bus are instead interpreted as the
actual external memory address.
The pinout seems to allow only a 6-bit address by the CPU. Actually, it is possible to program
the FMC data bus in Turnaround mode, so that it can forward to the external memory both the
address and the data, allowing a greater addressing space.



The SEcube™ Open Security Plaƞorm
Document ClassificaƟon: Public

Page 33 of 130
Release: 010

The CPU-FPGA interconnecƟon allows then to accommodate just 2 of these 4 banks of memory,
presenƟng both NE1 and NE2 pin in the CPU interface.

5.2.1 Configuring the FMC

Within the Open SDK, the subrouƟne encharged of iniƟalizing the Flexible Memory Controller is
MX_FMC_Init(). This funcƟon fills the members of 2 structures, Timing and Init, both for
reading and for wriƟng, which give the FMC the informaƟon necessary to being iniƟalized.
Initprovides all informaƟonon the typeof externalmemory connected, the datawidth, whether
it is synchronous or asynchronous, possible support for burstmodes, wait cycles, bus turnarounds
and so on. Through Timing instead, the programmer sets the setup and hold Ɵmes for address
and data, the possible number of turnaround cycles and one of the access modes available, each
one having its own specific Ɵming diagram with respect to the fundamental FMC signals.
Just as a maƩer of example, Figures 15 and 16 below show the Ɵming diagram of Access Mode A,
both for writes and reads.

Figure 15: Access Mode A Ɵming diagram for WRITE
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Figure 16: Access Mode A Ɵming diagram for READ

When NEx is low, a memory operaƟon is taking place. The address is forwarded and the setup
Ɵme for its stabilizaƟon is awaited. Then there is the data phase: if the NWE not asserted, the
address is intended to be a read address, and the CPUwaits for a data response from thememory
for the given data setup Ɵme. If a write is to be performed, NWE is asserted and a word to be
wriƩen is forwarded andmaintained for the data setup Ɵme, decided through seƫng the Timing
iniƟalizing structure. Times are to be carefully set according to the specificaƟon of the interfacing
memory and the raƟo between the CPU and the memory speed, in this case the FPGA design
maximum speed, provided by the synthesis tools.

Once the memory controller is configured, the external GPIO pins of the microcontroller have
to be set up to host the FMC interface. This can be demanded to the GPIO iniƟalizer funcƟon
MX_GPIO_Init(). Here, several calls to the HAL funcƟon HAL_GPIO_Init() consolidate in the
FMC configuraƟon registers the seƫngs contained in a GPIO_InitStruct structure. Through
this, it is possible to set preferences for a single or a group of GPIO pins, choosing themode (input,
output, alternate), the pull (default pullup, pulldown or no pull), the maximum speed at which
they have to react and the module which controls them. Here is an example of how GPIO pins
should be configured for supporƟng the FMC (cfr. Figure 14 for pin reference).

/*Configure GPIO pins : PF0 PF1 PF2 PF3 PF4 PF5 */
GPIO_InitStruct.Pin = GPIO_PIN_0 | GPIO_PIN_1 | GPIO_PIN_2 |

GPIO_PIN_3 | GPIO_PIN_4 | GPIO_PIN_5;
GPIO_InitStruct.Mode = GPIO_MODE_AF_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_FAST;
GPIO_InitStruct.Alternate = GPIO_AF12_FMC;
HAL_GPIO_Init(GPIOF, &GPIO_InitStruct);
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/*Configure GPIO pins : PE7 PE8 PE9 PE10 PE11 PE12 PE13 PE14
PE15 */

GPIO_InitStruct.Pin = GPIO_PIN_7 | GPIO_PIN_8 | GPIO_PIN_9 |
GPIO_PIN_10 | GPIO_PIN_11 | GPIO_PIN_12 | GPIO_PIN_13 |
GPIO_PIN_14 | GPIO_PIN_15;

GPIO_InitStruct.Mode = GPIO_MODE_AF_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_FAST;
GPIO_InitStruct.Alternate = GPIO_AF12_FMC;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);

/*Configure GPIO pins : PD8 PD9 PD10 PD14 PD15 PD0 PD1 PD4 PD5
PD7 */

GPIO_InitStruct.Pin = GPIO_PIN_8 | GPIO_PIN_9 | GPIO_PIN_10 |
GPIO_PIN_14 | GPIO_PIN_15 | GPIO_PIN_0 | GPIO_PIN_1 |
GPIO_PIN_4 | GPIO_PIN_5 | GPIO_PIN_7;

GPIO_InitStruct.Mode = GPIO_MODE_AF_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_FAST;
GPIO_InitStruct.Alternate = GPIO_AF12_FMC;
HAL_GPIO_Init(GPIOD, &GPIO_InitStruct);

/*Configure GPIO pin : PG9 */
GPIO_InitStruct.Pin = GPIO_PIN_9;
GPIO_InitStruct.Mode = GPIO_MODE_AF_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_FAST;
GPIO_InitStruct.Alternate = GPIO_AF12_FMC;
HAL_GPIO_Init(GPIOG, &GPIO_InitStruct);

5.3 Configuring the FPGA

5.3.1 Programming through JTAG interface

To be used, the FPGA has first to be loadedwith a design, transmiƩed in the form of a bitstream. A
bitstream is a long array of bytes, which encodes the content of every Look-Up Table (LUT) present
onto the FPGA, and how theymust be connected each other (rouƟng informaƟon). The bitstream
is produced by the synthesis tool, which can be instructed to output a C-compaƟble file, so that
the arrays can be staƟcally saved within the applicaƟon memory image of SEcube™ as constant
data.
Within the SDK source files, under ”/secube_sdk/libraries/Examples/TestFPGA”, an example of
bitstream file (”TEST_FPGA.h”) can be found. The folder also contains 2 library files, ”FPGA.h”
and ”FPGA.c”, which must be included in a SEcube™ device applicaƟon which wants to exploit the
FPGA. This liƩle library contains the funcƟon B5_FPGA_Programming(), which must be called
at the beginning of the applicaƟon to program the FPGA. This funcƟon controls in bit-banging the
JTAG interface between the CPU and the FPGA to put it in a programming state and to send the
bistream bytes one aŌer the other.
The FPGA programming phase needs the 5 pins of the JTAG interface to be correctly set through
apposite GPIO configuraƟon. TheGPIO iniƟalizaƟon funcƟon MX_GPIO_Init() should then con-
tain the following lines:
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/*Configure GPIO pins : PE3 PE5 PE4 PE6 */
GPIO_InitStruct.Pin = GPIO_PIN_3 | GPIO_PIN_4 | GPIO_PIN_5 |

GPIO_PIN_6;
GPIO_InitStruct.Mode = GPIO_MODE_OUTPUT_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_HIGH;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);

/*Configure GPIO pin : PE2 */
GPIO_InitStruct.Pin = GPIO_PIN_2;
GPIO_InitStruct.Mode = GPIO_MODE_INPUT;
GPIO_InitStruct.Pull = GPIO_NOPULL;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);

A detailed step-by-step guide to correctly iniƟalize the FPGA can be found in SecƟon 9.

5.3.2 Reset signal

A reset signal (CPU_FPGA_RST) has been allocated in the interface in order to give the CPU the
possibility of bringing the architecture implemented on the FPGA to a known starƟng state, im-
mediately aŌer programming or, in general, whenever the design is to be restarted. The corre-
sponding GPIO pin (PG2) can be configured as a normal output pin:

/* Set pin PG2 as reset for the FPGA */
GPIO_InitStruct.Pin = GPIO_PIN_2;
GPIO_InitStruct.Mode = GPIO_MODE_OUTPUT_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_FAST;
HAL_GPIO_Init(GPIOG, &GPIO_InitStruct);

and controlled in bit-banging when necessary through the dedicate HAL primiƟves:

HAL_GPIO_WritePin(GPIOG, GPIO_PIN_2, GPIO_PIN_SET);
HAL_GPIO_WritePin(GPIOG, GPIO_PIN_2, GPIO_PIN_RESET);

5.3.3 Clock signal

The clock signal to be provided to the FPGA (CPU_FPGA_CLK) has been assigned to pin PA8 in
the interface. The pin must be driven by the Reset and Clock Controller (RCC) module of the pro-
cessor21. The FPGA can be fed with a submulƟple of the nominal clock of the processor (HCLK),
which is 180 MHz. The value of the clock divisor must be chosen in accordance with the maxi-
mum speed reachable by the synthesized architecture, indicated by the synthesizer. The following
seƫngs show how to give a 60 MHz output clock out from pin PA8.

/* Enable clock for GPIOA */
__HAL_RCC_GPIOA_CLK_ENABLE();
/* Enable clock for SYSCFG */
__HAL_RCC_SYSCFG_CLK_ENABLE();

21For addiƟonal details, please refer to STM32F405/415, STM32F407/417, STM32F427/437 and STM32F429/439
advanced Arm-based 32-bit MCUs Reference Manual, Chapter 6: https://www.st.com/content/ccc/resource/
technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/
jcr:content/translations/en.DM00031020.pdf#page=150&zoom=100,0,116

https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=150&zoom=100,0,116
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=150&zoom=100,0,116
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=150&zoom=100,0,116
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/* Set pin PA8 as clock for the FPGA */
GPIO_InitStruct.Pin = GPIO_PIN_8;
GPIO_InitStruct.Mode = GPIO_MODE_AF_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_FAST;
GPIO_InitStruct.Alternate = GPIO_AF0_MCO;
HAL_GPIO_Init(GPIOA, &GPIO_InitStruct);

/* Set MCO1 output = PLLCLK with prescaler 3 = 180 MHz / 3 = 60
MHz */

__HAL_RCC_MCO1_CONFIG(RCC_MCO1SOURCE_PLLCLK, RCC_MCODIV_3);

The second parameter of the macro __HAL_RCC_MC01_CONFIG() can be changed to set an-
other prescaler. The parameter is RCC_MCODIV_X and X can assume values from 1 to 5, i.e., the
FPGA can run at frequencies from 180 MHz to 36 MHz. Once decided the operaƟng frequency, it
is also possible to change AddressSetupTime and DataSetupTime fields of the Timing struc-
tures relaƟve to read and write operaƟons of the FMC, to stretch them as preferred. Values are
expressed in terms of CPU clock cycles.

5.3.4 Interrupt signal

Pin PA9 of the interface has been allocated for hosƟng the interrupt signal coming from the FPGA
(CPU_FPGA_INT_N). Such a signal can be very useful to handle a good CPU-FPGA cooperaƟon,
since Ɵme-consuming tasks can be processed by the FPGA in parallel without blocking the CPU
acƟvity, which is only interrupted at the end to retrieve the results.
The pin can be configured as an input pin aƩached to the External Interrupt/Event Controller
(EXTI) andmanaged by the Nested Vectored Interrupt Controller (NVIC)22. The code extract below
is an example of how the interrupt pin can be set to trigger the execuƟon of the corresponding
excepƟon handler (EXTI9_5_IRQHandler()) at rising edges.

/* Set variables used */
EXTI_InitTypeDef EXTI_InitStruct;
NVIC_InitTypeDef NVIC_InitStruct;

/* Set pin PA9 as interrupt line from the FPGA */
GPIO_InitStruct.Pin = GPIO_PIN_9;
GPIO_InitStruct.Mode = GPIO_MODE_INPUT;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_FAST;
HAL_GPIO_Init(GPIOA, &GPIO_InitStruct);

/* Tell system that you will use PA9 for EXTI_Line9 */
SYSCFG_EXTILineConfig(EXTI_PortSourceGPIOA, EXTI_PinSource9);

/* PA9 is connected to EXTI_Line9 */
EXTI_InitStruct.EXTI_Line = EXTI_Line9;
/* Enable interrupt */
EXTI_InitStruct.EXTI_LineCmd = ENABLE;

22For addiƟonal details on EXTI and NVIC, please refer to STM32F405/415, STM32F407/417, STM32F427/437
and STM32F429/439 advanced Arm-based 32-bit MCUs Reference Manual, Chapter 12: https://www.st.com/
content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/
files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=371&zoom=100,0,116

https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=371&zoom=100,0,116
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=371&zoom=100,0,116
https://www.st.com/content/ccc/resource/technical/document/reference_manual/3d/6d/5a/66/b4/99/40/d4/DM00031020.pdf/files/DM00031020.pdf/jcr:content/translations/en.DM00031020.pdf#page=371&zoom=100,0,116
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/* Interrupt mode */
EXTI_InitStruct.EXTI_Mode = EXTI_Mode_Interrupt;
/* Triggers on rising edge */
EXTI_InitStruct.EXTI_Trigger = EXTI_Trigger_Rising;
/* Add to EXTI */
EXTI_Init(&EXTI_InitStruct);

/* Add IRQ vector to NVIC */
/* PA9 is connected to EXTI_Line9, which has EXTI9_5_IRQn vector

*/
NVIC_InitStruct.NVIC_IRQChannel = EXTI9_5_IRQn;
/* Set priority */
NVIC_InitStruct.NVIC_IRQChannelPreemptionPriority = 0x00;
/* Set sub priority */
NVIC_InitStruct.NVIC_IRQChannelSubPriority = 0x01;
/* Enable interrupt */
NVIC_InitStruct.NVIC_IRQChannelCmd = ENABLE;
/* Add to NVIC */
NVIC_Init(&NVIC_InitStruct);

5.4 Programming FPGA-based applicaƟons

The presence of the FPGA inside the SEcube™ Chip is certainly a plus for the programmer’s pos-
sibiliƟes. The CPU-FPGA system can be seen as a processor-coprocessor system, where the pro-
grammable logic is entrusted with a series of frequently used rouƟnes, among which encrypƟon
and hashing certainly stand out, while the control and decision-making part remains to the mi-
crocontroller. Besides the advantages brought by this parallelism, there is also the guarantee of
reaching the necessary levels of determinism and performance, in the case of Ɵme-criƟcal appli-
caƟons. The flexibility the FPGAs dispose of allows to keep up with innovaƟon in communicaƟon
standards: in fact, converters and controllers can be implemented for external interfaces which
may be not naƟvely present on the processor.
Thank to the usage of the FMC, the FPGA is seen by the processor as a normal peripheral, with
a given set of shared locaƟons starƟng from address 0x6000000 in the memory map. Thus, the
communicaƟon with the architecture present onto the FPGA is basically composed of reads and
writes, which in a high-level view form a master-slave protocol of queries and responses.
The communicaƟon can be held in polling or in interruptmode. In pollingmode, themasterwrites
its input stream and aŌer finishing awaits the end of the computaƟon by conƟnuously checking
the status (which can be “something to communicate”, or “nothing to communicate”). This is clas-
sically donewith a conƟnuous read of one of the shared locaƟons. In interruptmode, instead, the
master send the slave its inputs and then conƟnues its own computaƟon, while the slave reads
the input, performs its task and in the end triggers an interrupt request to the master.
For a correct communicaƟon, a complete driver to set up the communicaƟon should be composed
of two layers:

• a high-level layer, composed of the API for managing the tasks of the IP core implemented
(e.g., enctypt, sign, send, receive, etc.)

• a low-level layer, containing the low-level funcƟonaliƟes for the communicaƟon with the
FPGA, as iniƟalizing and reseƫng the FPGA, reading and wriƟng a word on the shared stor-
age, feeding the device with the clock, etc.
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It is likely that more than one funcƟonality is required from the FPGA, so that a single IP core
is not enough. To accomplish this, a central manager block may be necessary to redirect CPU
requests to the correct core, and to ensure that each communicaƟon with the CPU is exclusive
with a single component (transacƟon). An example of such a system has been developed and
is freely downloadable at https://www.secube.eu/resources/open-source-projects/, under the
name IP-core Manager for FPGA-based design.

https://www.secube.eu/resources/open-source-projects/
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6 The SEfile™ Library

6.1 IntroducƟon

Thepresent secƟonprovides a detailed presentaƟonof the SEfile™ library available for the SEcube™
Open Security Plaƞorm. The purpose of SEfile™ is to manage encrypted files with the SEcube™ ,
in parƟcular, SEfile™ allows to any soŌware to work on encrypted files exploiƟng the features of
the SEcube™ while keeping the data constantly encrypted on disk.
Any OS provides an abstracƟon layer in its kernel space, used to separate file system generic op-
eraƟons from their implementaƟon. This is performed thanks to a clean Virtual File System (VFS)
interface. Several implementaƟons for the VFS interface may coexist on the same machine, al-
lowing transparent access to different types of file systems mounted locally. Data protecƟon is
provided at this level of abstracƟon, bymeans of a dedicated security engine, hereinaŌer referred
to as secure layer.
A possible approach is to develop a secure layer which operates in the user space (Figure 17 on
the leŌ). This approach allows the developer to provide security funcƟonaliƟes without modify-
ing the underlying operaƟng system, which it is not always permiƩed. On the other hand, those
secure funcƟons do not override the standard ones, instead proposing themselves as a secure
alternaƟve. An interesƟng feature in this case is given by the possibility to develop a portable
layer, meaning that it is valid for different OperaƟng Systems (OSs).
Typically, OSs vendors follow another approach, based on a security level lying under the virtual
file system, hence not guaranteeing portability (Figure 17 on the right). The secure layer, in this
case, is transparent to the applicaƟon/user.

Figure 17: Secure Layer and Virtual File System: two different approaches.

In any case, whichever is the chosen approach, malicious user, or soŌware, may sƟll exploit ex-
isƟng flaws in the applicaƟon accessing to the secure layer or even in the secure layer itself. A
countermeasure to protect effecƟvely the data, thus, resorts to hardware key management tech-
niques applied to powerful embedded systems that can perform complex cryptographic opera-
Ɵons while, at the same Ɵme, increasing the confidence of data security. A secure device can
guarantee data protecƟon also when the host machine is compromised.
SEfile™ exploits the APIs Level L1 and other funcƟonaliƟes from the SEcube™ device (Figure 18).
It has been developed having in mind the need to ensure both simplicity of usage and security for
data at rest: it allows secure storage, retrieval and usage of informaƟon that could not be trusted
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if stored elsewhere, e.g., any personal computer or cloud service provider.

Figure 18: SEfile™ hierarchic organizaƟon.

Conceptually, SEfile™ targets any user that, by moving inside a secure environment, wants to
performbasic operaƟons on regular files. It must be pointed out that all encrypƟon funcƟonaliƟes
are demanded to the SEcube™ in their enƟrety. In addiƟon, SEfile™ does not expose to the host
device details about what or where it is reading/wriƟng data: thus, the host OS, which might be
untrusted, is totally unaware of what it is wriƟng.

6.2 Data ConfidenƟality

One of themost important consideraƟons a Secure File System deals with is the way in which files
are encrypted. A Secure File is made up of several sectors which are encrypted and signed (using
AES256-HMAC-SHA256) in order to grant confidenƟality, integrity and authenƟcaƟon. The first
sector is dedicated to the header, which provides informaƟon on the file itself (i.e. the ID of the
key and of the algorithm used to encrypt the file, the length of the file, the name of the file, and
other metadata) and contains padding if needed, while the other sectors contain the actual data
of the file (Figure 19).

Figure 19: Secure File structure.
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This structure has the great advantage of allowing data manipulaƟon on parts of a file by interact-
ing with a subset of its sectors. In this case, there is no need to decrypt and encrypt the whole file,
therefore, the Ɵme overhead is considerably lowered, especially in the common case of a read
or write operaƟon involving a single sector or few sectors. Is important to noƟce, however, that
when a sector of a file encrypted with SEfile™ is being used, the decrypted content of that sector
will be stored in the RAM memory of the host machine to which the SEcube™ is connected. This
behaviour is necessary because, in the end, the soŌware running on the host machine (i.e. a text
editor) must be able to access to the actual content of the encrypted file. A simplified overview
about how SEfile™ works is available in Figure 20.

Figure 20: Simplified step-by-step SEfile™ overview.

6.3 EncrypƟon Algorithm

The Advanced EncrypƟon Standard (AES), also known by its original name Rijndael, is a specifica-
Ɵon for the encrypƟon of data established by the U.S. NaƟonal InsƟtute of Standards and Technol-
ogy (NIST) in 200123. AES has been adopted by the U.S. government and is now used worldwide,
becoming a de-facto standard for guaranteeing data confidenƟality. It is a block cipher, since it is
based on a design principle known as a subsƟtuƟon-permutaƟon network, combinaƟon of both
subsƟtuƟon and permutaƟon of blocks of fixed size, and is fast in both soŌware and hardware.
However, a block cipher by itself is only suitable for the secure cryptographic transformaƟon (en-
crypƟon or decrypƟon) of one fixed-length group of bits (i.e., a block). Then, a mode of operaƟon
is an algorithm that uses a block cipher to provide an informaƟon service such as confidenƟality
or authenƟcity. A mode of operaƟon describes how to repeatedly apply a cipher’s single-block
operaƟon to securely transform amounts of data larger than a block.

23”Announcing the ADVANCED ENCRYPTION STANDARD (AES)”. Federal InformaƟon Processing Standards PublicaƟon
197. United States NaƟonal InsƟtute of Standards and Technology (NIST). November 26, 2001.
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Most modes require a unique binary sequence, oŌen called an iniƟalizaƟon vector (IV), for each
encrypƟon operaƟon. The IV should be non-repeaƟng and, for some modes, random as well.
The iniƟalizaƟon vector is used to ensure disƟnct ciphertexts are produced even when the same
plaintext is encrypted mulƟple Ɵmes independently with the same key. Block ciphers have one or
more block size(s), but during transformaƟon the block size is always fixed. Block cipher modes
operate on whole blocks and require the last part of the data to be padded to a full block if it is
smaller than the current block size.
Currently, the open source APIs of the SEcube™ (L1 and L0) supports only AES-256 as cipher al-
gorithm. SEfile™ leverages it by using the Counter (CTR) mode of operaƟon. The simplest of the
encrypƟon modes is the Electronic Codebook (ECB) mode. The message is divided into blocks,
and each block is encrypted separately.
Counter mode turns a block cipher into a stream cipher. It generates the next keystream block by
encrypƟng successive values of a ”counter”. The counter can be any funcƟon which produces a
sequence which is guaranteed not to repeat for a long Ɵme, although an actual increment-by-one
counter is the simplest and most popular. Today, CTR mode is widely accepted and any problems
are considered a weakness of the underlying block cipher, which is expected to be secure regard-
less of systemic bias in its input24.
This said, SEfile™ uses an encrypƟon scheme as follows. Each sector, except the header, is en-
crypted using AES-256-CTR, meaning that each block cipher depends on an ascending counter
which start from a randomly selected iniƟalizaƟon vector, generated using ad-hoc funcƟons pro-
vided from the crypto engine of any OS.
The header sector, instead, is encrypted usingAES-256-ECB, to be independent from any iniƟaliza-
Ɵon vector. Moreover, the header sector is not enƟrely encrypted because, in order to make the
SEfile™ library easily usable, each file must disclose the ID of the key and the ID of the algorithm
that were used to encrypt the file itself. This approach is adopted to speed-up the interacƟon
with the SEfile™ library, in fact anyone can read the first bytes of the header sector (because they
are stored as clear-text) to easily find out which key (not its actual value) and which algorithm
were used to encrypt it, then only the people with a SEcube™ device containing that specific key
will be able to decrypt the rest of the header and the other sectors. For example, given a security
domain where all involved actors use the same key ID nomenclature (i.e. they all agree about the
value of the key with ID equal to ‘1‘, ‘2‘, ‘3‘, and so on...) the header of a certain file may contain
the key ID ‘10‘ and the algorithm ID ‘3‘; this means that only the owners of SEcube™ devices con-
taining the key with ID ‘10‘ will be able to decrypt the file (using the correct algorithm of course).
NoƟce that, if someone else has got a SEcube™which stores a key with that same ID ‘10‘ but with
a different key value, obviously that person will not be able to decrypt the file.

6.4 Data authenƟcaƟon

On the other hand, there exists the problem of guaranteeing the integrity of the whole file against
malicious aƩackers. Therefore, each sector is signed so the integrity and the authenƟcity of each
one can be easily checked.

6.4.1 Algorithms

The Secure Hash Algorithm (SHA) is a family of cryptographic hash funcƟons published by the
NaƟonal InsƟtute of Standards and Technology (NIST) as a U.S. Federal InformaƟon Processing
Standard (FIPS).
SHA-3 uses the sponge construcƟon, in which data is ”absorbed” into the sponge, then the result

24Helger Lipmaa, Phillip Rogaway, and David Wagner. Comments to NIST concerning AES modes of operaƟon: CTR-
mode encrypƟon. 2000
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is ”squeezed” out25. In the absorbing phase, message blocks are XORed into a subset of the state,
which is then transformed. In the ”squeeze” phase, output blocks are read from the same subset
of the state, alternated with state transformaƟons. The size of the part of the state that is writ-
ten and read is called the ”rate” (oŌen denoted r), and the size of the part that is untouched by
input/output is called the ”capacity” (oŌen denoted c). The capacity determines the security of
the scheme. The maximum-security level is half the capacity.
Finally, a keyed-hash message authenƟcaƟon code (HMAC) is a specific type of message authen-
ƟcaƟon code (MAC) involving a cryptographic hash funcƟon and a secret cryptographic key. It
may be used to simultaneously verify both the data integrity and the authenƟcaƟon of a mes-
sage, as with any MAC. Any cryptographic hash funcƟon, such as MD5 or SHA-3, may be used in
the calculaƟon of an HMAC; the resulƟng MAC algorithm is termed HMAC-MD5 or HMAC-SHA
accordingly. The cryptographic strength of the HMAC depends upon the cryptographic strength
of the underlying hash funcƟon, the size of its hash output, and on the size and quality of the key.
An iteraƟve hash funcƟon breaks up a message into blocks of a fixed size and iterates over them
with a compression funcƟon. For example, MD5 and SHA-1 operate on 512-bit blocks. The size
of the output of HMAC is the same as that of the underlying hash funcƟon (128 or 160 bits in the
case of MD5 or SHA-1, respecƟvely), although it can be truncated if desired.
Within SEfile™ each sector, including the header, is signed using an authenƟcated signature ob-
tained with SHA-256-HMAC, meaning that the signature depends on both the data contained
in the sector itself and on a chosen encrypƟon key. To use two different keys to encrypt data
and to digest authenƟcaƟon, a feature increasing overall system security, SEfile™ leverages on
the pbkdf2() funcƟon already implemented within the SDK. This funcƟon, provided with a 32
byte long salt vector (randomly chosen), is used to generate parameters needed for the secure
sessions, such as a new key and the number of iteraƟons of the authenƟcaƟon procedure. This
mechanism is important to enhance security, because even if one key is unveiled, the second one
would be too difficult to obtain.
The procedure enforced within SEfile™ to ensure data protecƟon and confidenƟality is hereby de-
scribed. Firstly, the file is divided into sectors containing each exactly 512 bytes (constant defined
as SEFILE_SECTOR_SIZE that can be modified as long as it is bigger than 256 and it is a power
of 2).
Except for the first (the header), each sector is divided into three main fields: data, length and
signature. The length field is composed of 2 bytes and stores the number of valid user data bytes
contained in the data field. The signature field is composed of 32 bytes and stores the result of
the authenƟcated signature, to check if the sector is corrupted or not and if the data stored in the
sector were wriƩen by an authorized user.
The data field represents the effecƟve payloadwhere the user data are stored, it can be computed
as SEFILE_LOGIC_DATA = SEFILE_SECTOR_SIZE − 2 − 32 (bytes).
The first sector of the Secure File follows a different structure from the others and is not used
to store user data; instead it contains necessary informaƟon about the file itself, organized as
follows:

typedef struct {
uint8_t nonce_pbkdf2[32];
uint32_t key_id;
uint16_t algorithm;
uint8_t padding[10];
uint8_t nonce_crt[16];
uint8_t magic;
uint8_t ver;

25Guido Bertoni, Joan Daemen, Michaël Peeters and Gilles Van Assche. ”The Keccak sponge funcƟon family: Specifi-
caƟons summary”.
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uint8_t uid;
uint8_t uid_cnt;
uint8_t fname_len;

} SEFILE_HEADER

Within this structure, nonce_pbkdf2 is a 32 byte long salt used for generaƟng a different key to
authenƟcate digest. Key_id and algorithm are the IDs of the key and of the algorithm used to
encrypt the file. Padding is just a 10 byte array used to pad the size of the data to be encrypted
to a mulƟple of the cipher’s block size. Nonce_crt is the random iniƟalizaƟon vector used as
counter for encrypƟng all the data sectors of the secure file. The fname_len field contains the
length of the filename which is wriƩen right aŌer the header fields.
The magic field might be used for represenƟng what type of file has been encrypted. The ver
field is used for represenƟng with what version of SEfile™ it has been encrypted. The uid and
uid_cnt fields, finally, are designed to host informaƟon about the user who encrypted the file
and its permission. However, all these features are not supported yet.
All the unused bytes for padding of the header sector, and all the unused bytes obtainedwhen any
sector is not filled up to its capacity, are randomly chosen to avoid a known plain-text aƩack, an
aƩack model for cryptanalysis where the aƩacker has access to both the plaintext (called a crib),
and its encrypted version (ciphertext). These can be used to reveal further secret informaƟon
such as secret keys and code books.

6.5 The SEfile™ class

SEfile™ was originally wriƩen in C, however, it has been ported to C++ in order to take advantage
of many useful features. In parƟcular, SEfile™ is now object oriented and it exploits paradigms
like the RAII to grant usability along with correct memory management. The SEfile class allows to
create SEfile™ objects, each object is used to manage a specific file with SEfile™ . A SEfile™ object
is characterized by several aƩributes, the most important are:

• the l1 aƩribute is a pointer to the L1 object that is used to communicate with the SEcube™
connected to the host machine;

• the EnvKeyID aƩribute is a 4 byte unsigned integer that idenƟfies the key to be used to
encrypt or decrypt the data of the file;

• the EnvCrypto aƩribute is a 2 byte unsigned integer that idenƟfies the algorithm to be
used to encrypt or decrypt the data of the file.

These aƩributes can be set exploiƟng the constructors available for the SEfile™ object but they
can be set later as well using specific APIs. NoƟce that the constructors of the SEfile™ object do
not automaƟcally open or create any file, that must be done manually using dedicated APIs. On
the other hand, the destructor of the SEfile™ object automaƟcally closes the file managed by the
object, if the file is sƟll open, and it also releases all the resources required by the object itself.
Each SEfile™ object exposes several APIs that can be used to open, close, read, and write the
underlying file. These APIs emulate the funcƟonaliƟes available in the file system interfaces of
most OSs, however, their content is specialized to take into account the special structure of each
file.

6.6 SEfile™ implementaƟon for encrytped SQL databases

SEfile™ has been developed with the goal of being independent from the soŌware working at the
higher levels, but this is not always true. SEfile™ , in fact, uses a customfile structure (Figure 19) to
grant security properƟes to the data; however, this structure may collide with other assumpƟons
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that the applicaƟon at the higher levels may have about the underlying file system.
This was the case of SQLite, a popular SQL database engine. The first release of SEfile™ provided
a demo of the library applied to the SQLite Browser tool, however, SEfile™was not working prop-
erly with SQLite.
Since SQLite was chosen as an important component to implement the SEkey™ library, a SEfile™
version specifically customized for SQLite has been developed. This custom SEfile™ version al-
lows to implement an encrypted SQLite database with all the security properƟes of SEfile™ . The
main difference between the standard SEfile™ library and the customized one is the usage of a
slightly different file sector structure which is compaƟble with the assumpƟons of SQLite about
the underlying file system. Because of this custom structure, you will also find custom APIs that
must be used exclusively with SQLite encrypted databases; this APIs are the same of the standard
version but they have been modified to work with the different sector structure.
In conclusion, if you simply want to try SEfile™ and/or SEkey™ and if you do not need to manage
encrypted SQL databases, then you can simply ignore the APIs related to the encrypted database.
On the other hand, if you want to use SEfile™ to store some data into encrypted SQL databases
and the SQLite database engine is sufficient for your goal, then you know that there are specialized
SEfile™ APIs for that purpose so that you do not need to worry about low level details.

6.6.1 The interface between SQLite and SEfile™

The interoperability between SQLite and SEfile™ is granted by a soŌware layer called Custom Vir-
tual File System (CVFS). This layer allows the developers to implement a customized file system
interface upon the plaƞorm where the SQLite engine is supposed to run, in the case of SEfile™
the CVFS was developed to work with Windows and Unix operaƟng systems. The purpose of the
CVFS is to force SQLite to use the abstracƟons provided by SEfile™ instead of the tradiƟonal file
system interface offered by the OS; in this way we can automaƟcally obtain a SQL database with
all the security properƟes of SEfile™ .
The starƟng point of this work has been the official template offered as example for implement-
ing a CVFS interface distributed with SQLite. This template, by default, is compaƟble only with
Unix-based OSs but it was tweaked to work also with Windows. Moreover, the CVFS implements
a simple soŌware cache for reducing the number of disk accesses, increasing the overall perfor-
mance. Precompiler definiƟons are set so that the SQLite engine is forced to use this CVFS.
Hereby it is listed a subset of the most important CVFS interface funcƟons that have been imple-
mented so that SQLite uses SEfile™ to manage files and databases. NoƟce that you never need
to call these funcƟons, in fact they are only used by the SQLite engine. The only reason you may
want to take a look at the details of these funcƟons is if you want to improve the custom virtual
file system.

SQLITE_API int SQLITE_STDCALL sqlite3_os_init(void)
SQLITE_API int SQLITE_STDCALL sqlite3_os_end(void)

These two funcƟons are respecƟvely used to assign and release the data structure made up by
pointers to the rest of VFS interfaces that has been associated with common I/O operaƟons.

static int SecureDirectWrite(SecureFile *p, const void *zBuf,
int iAmt, sqlite_int64 iOfst)

This funcƟon is used to wrap a write operaƟon, it accepts as parameters a custom file descriptor,
the buffer that should be wriƩen, the number of bytes to be wriƩen and the offset from the start
of the file. This funcƟon checks if the soŌware cache should be flushed to disk, change the file
pointer to iOfst and the issue a secure_write() call.

static int SecureRead(sqlite3_file *pFile, void *zBuf, int iAmt,
sqlite_int64 iOfst)
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This funcƟon is used to wrap a read operaƟon, it accepts as parameters a custom file descriptor,
the buffer that should be read, the number of bytes to be read and the offset from the start of the
file. This funcƟon checks if the soŌware cache should be flushed to disk, change the file pointer
to iOfst and the issue a secure_read() call.

static int SecureTruncate(sqlite3_file *pFile, sqlite_int64 size
)

This funcƟon is used to change the size of the pointed file pFile to size. In this case it simply
issues a secure_truncate().

static int SecureSync(sqlite3_file *pFile, int flags)

This funcƟon is used to flush OS buffers (and not the soŌware cache) to disk thanks to
secure_fsync(). In this case the flags are ignored.

static int SecureFileSize(sqlite3_file *pFile, sqlite_int64 *
pSize)

This funcƟon firstly writes the pending cache to disk, then it returns the current size of the file
thanks to secure_getfilesize(). Since sqlite3_file is highly customizable, the path was
added to the file descriptor to be compaƟble to the SEfile™ API.

static int SecureOpen(sqlite3_vfs *pVfs, const char *zName,
sqlite3_file *pFile, int flags, int *pOutFlags)

This funcƟon is used to manage opening/creaƟng of a secure database thanks to secure_open
(). In this case pVfs and pOutFlags were ignored, while zName is the path to the file that
should be opened, pFile is the pointer to the file descriptor obtained, and flags is used to
determine how the file should be opened.
Pay aƩenƟon to the following flags combinaƟons:

• The combinaƟon (SEFILE_READ, SEFILE_NEWFILE) is not allowed and therefore fails;

• The combinaƟons (SEFILE_READ, SEFILE_OPEN) and (SEFILE_WRITE,
SEFILE_OPEN) work only if the file already exists.

static int SecureDelete(sqlite3_vfs *pVfs, const char *zPath,
int dirSync)

This funcƟon is used to delete a file pointed by zPath and it was developed as a wrapper to
unlink() in Unix and DeleteFile() in Windows, thanks to crypto_filename() funcƟon.
In this case dirSync parameter is ignored.

static int SecureFullPathname(sqlite3_vfs *pVfs, const char *
zPath, int nPathOut, char *zPathOut)

This funcƟon is used to retrieve the full path of a secure database pointed by zPath by wriƟng at
most nPathOut bytes to zPathOut. In this case pVfs is ignored.
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6.7 SEfile™ APIs

Here we provide a simplified and high-level overview about the SEfile™ APIs, noƟce that there
are other funcƟons inside the SEfile™ library that are used for internal purposes. The APIs listed
here are everything you need to profitably use the library; however, please refer to the Doxygen
documentaƟon to find out more details about the APIs and the other funcƟons of SEfile™ .
Inside the source code of the SEfile™ library, you will also find APIs developed to be used ex-
clusively with the SQLite database engine. The name of these funcƟons always begins with ‘se-
curedb‘. Some of these funcƟons belong to the SEfile class, they should not be used explicitly
because they are automaƟcally called by the tradiƟonal SQLite C interface (i.e. sqlite3_open
() internally calls securedb_secure_open()). The only SEfile™ funcƟons reserved to SQLite
that you may want to use directly are securedb_ls() and securedb_recrypt().

uint16_t secure_init(L1 l1, uint32_t keyID, uint16_t crypto)
uint16_t secure_finit()

These funcƟons are used to setup the basic aƩributes of each SEfile object is in associaƟon with
a file encrytpted with SEfile™ . In parƟcular:

• thel1parameter is a pointer to the L1 object that is used to communicatewith the SEcube™
connected to the host machine;

• the keyID parameter is a 4 byte unsigned integer that idenƟfies the key to be used to
encrypt or decrypt the data of the file;

• the crypto parameter is a 2 byte unsigned integer that idenƟfies the algorithm to be used
to encrypt or decrypt the data of the file.

These three aƩributes are specific to each SEfile object, obviously a dedicated SEfile object is
required for each file that needs to be managed by SEfile™ . The secure_init() is used to ini-
Ɵalize those aƩributes, the secure_finit() is used to reset those aƩributes to default values
(i.e. NULL for the SEcube pointer, 0 for the key and the algorithm).
NoƟce that the only aƩribute that you always need to setup is the l1 pointer because SEfile™
must communicate with a SEcube™ . On the other hand, the keyID and crypto aƩributes need
to be set only when you want to create a file. If the file already exists and you simply want to
access to it, then SEfile™ will automaƟcally adjust the key and the algorithm according to the key
ID and algorithm ID specified in the header sector of the file itself (provided that you have the
right key stored on your SEcube™ ).
The usage of these APIs is notmandatory, you can simply exploit the constructors available for the
SEfile object. NoƟce that destructor of the SEfile object automaƟcally calls the secure_finit()
so that the user does not have to worry about resources deallocaƟon.

uint16_t secure_open(char *path, int32_t mode, int32_t creation)

This funcƟon, given the name of a file as plaintext (relaƟve path or absolute path), is used to open
an exisƟng file or create a new one. The name of the file is modified with the crypto_filename
() funcƟon, which transforms it into its digest (64 hex chars) computed with SHA-256. NoƟce
that there is also another funcƟon, called secure_create(), that is used automaƟcally by the
secure_open() to create a new file; the secure_create() should never be called directly
because it is intended to be used exclusively by the secure_open().
The mode parameter is used to specify read-only or read-write privilege, the creation param-
eter is used to specify the opening policy (i.e. SEFILE_NEWFILE forces the creaƟon of the file,
SEFILE_EXISTING opens an exisƟng file). A real write-only mode has not been implemented
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since a dedicated secure_write() funcƟon exists. NoƟce that you must specify in advance if
you want to create the file or if you want to open it; there is not a mode to open it if exists or
create it if it does not exists (you can implement it by yourself generaƟng the encrypted file name
with crypto_filename() and checking if that file exists or not).
If a new file is created, the header sector is filled with appropriate informaƟon (i.e. the ID of the
encrypƟon key of the SEfile object upon which the method is called, the ID of the algorithm, the
name of the file, etc.), then the header sector is encrypted and signed (except for the key_id,
algorithm, and nonce_pbkdf2, as it is needed to check the signature of the header sector
itself) before wriƟng it to disk.
If an exisƟng file is opened, the clear text part of the header sector is read to set the correct key
ID and algorithm in the SEfile object, then the rest of the header is decrypted and the signature
is checked; if everything is correct and the key can be used to decrypƟon, the file can be used.
Independently from the actual behaviour of the secure_open() funcƟon, if it succeeds the file
pointer is set to the first byte of the first sector placed aŌer the header.
The following algorithm demonstrates how the secure_open() works.

Algorithm 1 How a secure file is opened or created
funcƟon SECURE_OPEN(in path, in mode, in creaƟon)
if creaƟon == SEFILE_NEWFILE then
return SECURE_CREATE()

end if
// exisƟng file (SEFILE_OPEN) from now on
generate encrypted filename with crypto_filename()
OS system call to open the encrypted file according to mode
set the key ID and algorithm ID according to the header content
check if the inherited key ID can be used for decrypƟon
decrypt header and check signature
return

end funcƟon

Algorithm 2 How a secure file is created
funcƟon SECURE_CREATE(in path, in hFile, in mode)

check if specified key can be used for encrypƟon
generate encrypted filename with crypto_filename()
OS system call to create the encrypted file according to mode
populate the header of the file
encrypt and sign the header sector
write the header sector to disk
move the file pointer to the first byte aŌer the header sector
return

end funcƟon

uint16_t secure_close()

This funcƟon simply closes the file associated to the SEfile object and deallocates all the resources
that were acquired. This funcƟon is called automaƟcally by the destructor of the SEfile object,
therefore you do not need to call it manually all the Ɵme (but you are suggested to, because it is
good pracƟce).

uint16_t secure_read(uint8_t *dataOut, uint32_t dataOut_len,
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uint32_t *bytesRead)
The secure_read() funcƟon works as the read() in Unix and the ReadFile() in Windows,
adding all the needed operaƟons related to the secure file management.
The number of bytes requested as clear text is provided in uint32_t dataOut_len while the
actual number of read bytes is stored in bytesRead. In details, the operaƟons performed are:
starƟng from the posiƟon pointed by the file pointer the funcƟon extracts sequenƟally all the sec-
tors related to the requested porƟon of data to be read, check for its integrity by looking at the sig-
nature, decrypts the sector and concatenates the read data in the output buffer dataOut. AŌer
that, the file pointer points aŌer the last byte read. A read operaƟon issued requesƟng a number
of bytes that is not aligned to the sector size and is not a mulƟple of SEFILE_LOGIC_DATA will
lead to performance degradaƟon, since it sƟll needs to decrypt the whole sector.
The implemented funcƟonality is shown in the following algorithm.

Algorithm 3 How a secure file is read
funcƟon SECURE_READ(out dataOut, in dataOut_len, out bytesRead)

check if specified key can be used for decrypƟon
set number of read bytes to zero
do

read, decrypt and verify signature of current sector
append decrypted data do dataOut
bytesRead = bytesRead + data read
dataOut_len = dataOut_len - data read
go on with next sector if required

while dataOut_len > 0
end funcƟon

uint16_t secure_write(uint8_t *dataIn, uint32_t dataIn_len)

The secure_write() funcƟonmasks the write() in Unix and the WriteFile() in Windows,
adding all the needed operaƟons related to the secure file management. The funcƟon writes in
the file the data sent as clear text in the buffer. In parƟcular, the funcƟon divides the buffer into
sectors, then it encrypts and signs each sector and writes it in the specified posiƟon in the file.
AŌer this operaƟon, the file pointer points aŌer the last byte wriƩen.
In this case, it has been chosen to not return the actual number of wriƩen bytes since if the op-
eraƟon fails in wriƟng dataIn_len bytes it would result as an error.
If a secure_write() is issued requesƟng to write a number of bytes that is not aligned to the
sector size and is not amulƟple of SEFILE_LOGIC_DATA, since it sƟll needs to decrypt the whole
sector, it will lead to performance degradaƟon.
The implemented funcƟonality is shown in the following algorithm.

Algorithm 4 How a secure file is wriƩen
funcƟon SECURE_WRITE(in dataIn, in dataIn_len)

check if specified key can be used for encrypƟon
if file pointer not aligned to sector size then

read, decrypt and verify signature of current sector
store inside the buffer the sector to be wriƩen

end if
do

append data from dataIn to output buffer
encrypt and sign the sector to be wriƩen
write the sector to disk
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decrement the amount of data sƟll to be wriƩen
while dataIn_len > 0

end funcƟon

uint16_t secure_seek(int32_t offset, int32_t *position, uint8_t
whence)

This funcƟonmoves the file pointer by offset bytes, taking care of the effecƟve byte of user data
and skipping the bytes related to the overhead introduced by SEfile™ itself (i.e. header sector,
signature field and data length). The parameter whence is used to choose if the user wants move
the file pointer from the beginning of the file, from the current posiƟon, or from the end of the
file. The position parameter is used to store the logic value where the file pointer is set aŌer
issuing secure_seek().
If the desƟnaƟon exceeds the file size, the file is resized by adding zeros unƟl the specified po-
siƟon. This funcƟon has proper mechanisms to avoid jumping inside the header sector. The
implemented funcƟonality is shown in the following algorithm.

Algorithm 5 How a secure file pointer is moved
funcƟon SECURE_SEEK(in offset, out posiƟon, in whence)

retrieve the size of the file using get_filesize()
if offset > file size then

move the file pointer to the last sector using OS system call
add as many bytes equal to zero as necessary to reach a file size equal to the offset
return posiƟon = current file pointer posiƟon

end if
computer file pointer desƟnaƟon according to whence
move the file pointer to desƟnaƟon using OS system call
return posiƟon = desƟnaƟon

end funcƟon

uint16_t secure_truncate(uint32_t size)

This funcƟon resizes the file to size bytes. It takes care of the sectors and leaves the file pointer
to the end of the file (aŌer the last byte of user data).
If the specified file is bigger than the original, sectors are filled with zeros, otherwise data in ex-
cess are lost. The implemented funcƟonality is shown in the following algorithm.

Algorithm 6 How a secure file is truncated
funcƟon SECURE_TRUNCATE(in newsize)

retrieve the size of the file using get_filesize()
if newsize > file size then
return SECURE_SEEK(newsize - file size, nullptr, end of file)

end if
compute which sector will become the last one of the file
move file pointer to the computed sector
read, decrypt and verify the last sector
keep only the data of that last sector that must be preserved by the truncaƟon
truncate the file using the OS system call
write back the previously saved data with the secure_write()

end funcƟon
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uint16_t secure_sync()

This funcƟon is used in case it is needed to be sure that the OS buffers are correctly flushed to the
physical file.

uint16_t get_secure_context(std::string& filename, std::string *
keyid, uint16_t *algo)

This funcƟon, given the clear text name of a file, returns the ID of the key and the ID of the algo-
rithm used by SEfile™ to encrypt and authenƟcate that file. This is useful in many situaƟons, for
example when working with other funcƟons like secure_ls().

uint16_t secure_recrypt(std::string path, uint32_t key, L1 *
SEcubeptr)

This funcƟon is used to decrypt and encrypt again, with a new key, a file managed by SEfile™ that
was encrypted with a key that is considered not secure anymore. This funcƟon ideally should be
used together with the SEkey™ KMS; however, it can be easily used also without having the KMS
running (as long as you resort to keys which are not in the range of IDs managed by the KMS).
The funcƟon takes as parameters the clear text name of the file, the key to be used for the new
encrypƟon and the pointer to the L1 object used to communicate with the SEcube™ .
If the funcƟon succeeds, the old file will be replaced with a new file whose content is idenƟcal
and encrypted with the new key; the old file will be deleted. If the funcƟon fails, no changes are
applied.
NoƟce that the same funcƟon is available also for encrypted SQLite databases under the name of
securedb_recrypt().

uint16_t crypto_filename(char *path, char *enc_name, uint16_t *
encoded_length)

This funcƟon computes the encrypted name of the file specified at posiƟon path and writes the
result to enc_name; the quanƟty of bytes wriƩen is saved in encoded_length. The filename
is computed using the SHA-256 algorithm, so there is no decrypƟon funcƟon to obtain its clear
text name unless the header sector is decrypted. Since the service which computes the SHA-256
works with 32 Bytes block, its result is always on 32 bytes, and it is represented as hexadecimal
values in ASCII encoding, meaning that for each byte there will be 2 character, resulƟng in a 64
characters length.
In any case, this funcƟon takes care of parsing path so in enc_name will be copied everything
that comes before a “/” or “\” character to compute just the hash of the filename to encrypt.

secure_getfilesize(char *path, uint32_t * position, L1 *
SEcubeptr)

This funcƟon is used to retrieve the total logic size (how many bytes of valid data, exluding the
SEfile™ overhead) of an encrypted file pointed by path, the result is stored in position. The
SEcubeptr parameter is a pointer to the L1 object used to communicate with the SEcube™ con-
nected to the host machine. This funcƟon does not need to be called upon a SEfile object but can
be normally used simply passing the clear text name of the file. NoƟce that the logic size of the
file will always be smaller than the physical size given the overhead introduced by SEfile™ .
The implemented funcƟonality is shown in the following algorithm.

Algorithm 7 How a secure file size is computed
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funcƟon SECURE_GETFILESIZE(in path, out posiƟon, in SEcubeptr)
open the file pointed by path using secure_open()
move the file pointer to the last sector of the file using OS system call
if number of sectors of the file = 1 then
return posiƟon = 0

end if
read, decrypt, verify the last sector of the file
posiƟon = ((total file size / sector size) - 1) * valid bytes in each sector + valid bytes in last sector
close the file pointed by path using secure_close()
return posiƟon

end funcƟon

secure_ls(string& path, vector<pair<string, string>>& list, L1 *
SEcubeptr)

This funcƟon is used to list the content of a directory containing encrypted files and/or directo-
ries. The path parameter tells to the funcƟon where to search, the list parameter stores as
first element of each pair the name of the file or directory as it appears to the user (i.e. the en-
crypted file name of a file managed by SEfile™ ) and as second element the actual name of the
file or directory. The third parameter is the pointer to the L1 object used to communicate with
the SEcube™ .
NoƟce that this funcƟon works with any file or directory. In parƟcular, if the name to list is not
recognized as a name belonging to the ‘nomenclature‘ of SEfile™ , it is simply copied as it is. If this
funcƟon finds encrypted files managed by SEfile™ APIs specific for the SQLite database engine,
then their names will not be decrypted; to list their real names use instead the securedb_ls()
funcƟon. The implemented funcƟonality is shown in the following algorithm.

Algorithm 8 How to discover the names of encrypted files in a folder
funcƟon SECURE_LS(in path, out list, in SEcubeptr)

retrieve list of files and directories within specified directory using OS system call
do
if current element in list is a directory then

decrypt directory name
if decrypƟon successful then

add decrypted name to list
else

add original name to list
end if

else if current element in list is a file then
open the file and try to decrypt the header
if decrypƟon successful then

add clear text name to list
else

add original name to list
end if

end if
while all files and directoris within specified directory have been processed

end funcƟon

uint16_t secure_mkdir(string& path, L1 *SEcubeptr, uint32_t key)



The SEcube™ Open Security Plaƞorm
Document ClassificaƟon: Public

Page 54 of 130
Release: 010

This funcƟon masks the mkdir() funcƟon of the Unix environment and the CreateDirectory
() funcƟon of Windows, but it does not implement the whole funcƟonaliƟes of those funcƟons.
Since directories are created using a wrapper to the OS system call, it is not possible to achieve a
mechanism like the one employed for regular files, so it has been decided to use this encrypƟon
scheme, leveraging to crypt_dirname(), just for the name of the directory: the first 8 char-
acters are the hexadecimal representaƟon in ASCII of the key ID, the rest is obtained compuƟng
the AES-256-ECB of the name specified as clear text. The SEcubeptr parameter is, as usual, the
pointer to the L1 object used to communicate with the SEcube™ ; the key parameter is the ID of
the key to be used to encrypt the name of the directory.
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7 The SElink™ Library

7.1 Premise

SElink™ is currently undergoing a significant revision. It will be totally rewriƩen, in order to be
more coherent with the other libraries of the SEcube™ such as SEfile™ and SEkey™ . The new
version of SElink™ is expected to be released in late Q3 or early Q4 of 2020. The documentaƟon
in this chapter is therefore to be considered outdated but it is kept here in case anyone needed
further details about the first verison of SElink™ .

7.2 IntroducƟon

SElink™ is a soŌware applicaƟon that uses the SEcube™ open plaƞorm to secure the network
traffic. It can encrypt network streamsoriginaƟng fromany applicaƟon, regardless the applicaƟon-
level protocol.
SElink™ is a reference implementaƟon of an applicaƟon on top of the L1 API for SEcube™ . By using
SElink™ it is possible to add a secure network layer to any soŌware, without modifying its code.
In other words, the user can employ any of his/her favorite network-enabled soŌware (e.g., web
browser, remote desktop viewer) and entrust the customizable security features to the SEcube™
plaƞorm, in a way that is completely transparent to the user, allowing him to exploit the benefits
of the security funcƟonaliƟes without having deep knowledge about security.
The soŌware does not need to be aware of the presence of SElink™ and will funcƟon as usual,
because SElink™ intercepts connecƟons at a lower level.
SElink™ is made up of two macro-components (Figure 21):

• Client-side soŌware: it is installed on the host that iniƟates the connecƟon. It includes a
driver, a background service and a graphical user interface. The driver intercepts outgoing
connecƟons and redirects them to the service. The service bridges the connecƟon to the
desƟnaƟon, applying the encrypƟon layer

• Server-side soŌware: it is installed on the host that accepts the connecƟon. It includes a
background service and a graphical configuraƟon uƟlity. The service is symmetrical to the
client-side service, bridging the encrypted connecƟon to its final desƟnaƟon.

The Client-side components are:

• SElink™ driver

• SElink™ service

• SElink™ GUI.

The driver is needed to intercept all new TCP connecƟons, system-wide, while not modifying
any applicaƟon (Figure 22). The driver redirects all connecƟons to the service, which can decide
whether each should be encrypted or not. The graphical user interface is a disƟnct applicaƟon
too, becauseWindows services are not intended to create GUI elements within the user’s session.
The server-side components are:

• SElink™ gateway

• SElink™ gateway web UI.

On the server’s side a “gateway” applicaƟon, running as daemon, bridges the secure connecƟons
created by a SElink™ client host to any server soŌware (Figure 23). This daemon can by configured
by directly ediƟng its configuraƟon file, or by using a graphical interface through anyweb browser.
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Figure 21: SElink™ architecture.

Figure 22: ConnecƟon establishment process: each directed arrow represents a TCP connecƟon
request.

Figure 23: Final connecƟons: each bidirecƟonal arrow represents a TCP connecƟon.
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7.3 SElink™ driver

The choice of implemenƟng a driver has been taken since it cannot be tampered from other user-
mode applicaƟons, making it more secure and reliable; moreover, it leaves no traces within the
applicaƟons’ executable memory, so it goes undetected by most soŌware protecƟon frameworks
and does not interfere with applicaƟons.
AŌer some experiments with other frameworks, the driver was ulƟmately developed with the
Windows Filtering Plaƞorm (WFP) API. The superseded Transport Driver Interface (TDI) API was
discarded a priori, because of its deprecaƟon. NDIS, despite having all the needed features, would
have required more effort to achieve the same result.
The currentWFP soluƟon is very lean, consistent with the pracƟce of performing the least needed
amount of work within the kernel. In fact, any faulty code within the kernel can cause a system
crash, hence the need to restrict kernel-mode code to the minimum necessary amount.
An important reason why the filtering logic has been implemented in user-space is that not all
operaƟons can be performed as easily within the kernel. To be more specific, rouƟnes within
the kernel run at different Interrupt Request Levels (IRQL), depending on their priority. Each of
the IRQLs has a mask for interrupts, with higher levels masking more interrupts. At higher IRQLs
funcƟonsmust complete as soon as possible, deferring any Ɵme-consuming work. Also, funcƟons
that can cause a page fault, such as operaƟons on pageable memory, must only be performed at
the lower levels that do not mask the specific interrupt. Specifically, WFP filter callback funcƟons
run at IRQL = DISPATCH_LEVEL, and cannot access pageable memory nor perform file I/O.
The SEcube™ plaƞorm uses file I/O to communicate with the device; its host API would need to
be completely redesigned to use it within a driver. The driver is wriƩen in C, as most drivers are.
There is no official support to any other language for driver developmentwith theWindowsDriver
Framework. As a maƩer of fact, most funcƟons from the C standard library cannot be used either.
For network filtering the API Hooking approach was considered and discarded because of the dis-
advantages discussed in the previous chapter. LSPs have not been considered for the deprecaƟon
issue. Other user-space opƟons involve either modifying applicaƟons to add support for SElink™
or restrict the applicability of SElink™ to applicaƟons supporƟng proxy protocol (e.g., HTTP/HTTPS
proxy or SOCKS). Hence the decision to develop a kernel-mode filter.
The NDIS API was considered first, but considerable effort would have been required to keep track
of TCP streams from the level at which NDIS filters operate. Windows Filtering Plaƞorm (WFP) has
been chosen over NDIS because of its support for transport level filtering. Also, WFP is recom-
mended by MicrosoŌ itself as a possible alternaƟve.
The driver has the main purpose of redirecƟng outgoing TCP connecƟons from any applicaƟon to
a local proxy service.
The driver needs to exchange informaƟon with the service mainly for the following purposes:

• Sending informaƟon about the redirected connecƟon, so that the service can bridge the
connecƟon to the intended desƟnaƟon

• Geƫng the process ID of the service.

ConnecƟon informaƟon is passed to the service through the redirect context, as stated before.
As for the PID, the service sets a WFP Provider Context at startup, which can be read within the
driver. Since the provider context cannot be read within the callback funcƟons, because of the
IRQL, a periodic Ɵmer task running at IRQL = PASSIVE_LEVEL polls the provider context at a
fixed interval.
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7.4 SElink service

The SElink™ service is the main component of the client-side soŌware: all the connecƟons orig-
inaƟng from the machine go through the service, which decides which connecƟons should be
encrypted and which should not.
The choice of the programming language, C++, is driven by mulƟple reasons:

• It is mandatory that the service performs well with many connecƟons (hundreds to thou-
sands) because it must handle most of the network traffic of the machine

• The service needs some data structures such as maps, sets, linked lists, which are not part
of the C standard library

• The service must interface directly with the Windows API to be able to communicate with
the driver

• The service must use a SEcube™ device, whose API is only available for C.

C++ is a mulƟ-paradigm language that seamlessly combines low-level and high-level features.
It can directly include C code, perform raw virtual memory access, but is also suited to object-
oriented and funcƟonal approaches. Plus, following the introducƟon of the C++11 standard, it
has vast standard library that includes a common interface to some OS-specific features such as
threading.
The boost library is also included for the following features:

• Command line parameters: used to parse the command line, generate a help message and
useful error descripƟon messages

• JSON file parsing: for the configuraƟon files

• Filesystem operaƟons: to manipulate paths and access files through a OS-independent in-
terface

• String formaƫng: used for some log messages

• Logging: to conveniently categorize log messages and possibly redirect them to a log file

• Hashing: for faster matching of an array/string against a set of arrays/strings

• Event-based socket I/O: used to accept connecƟons and react to network events.

Since this applicaƟon shares much of the logic with its cross-plaƞorm server-side counterpart,
most of the classes are designed to be cross-plaƞorm, and are reused in SElink™ gateway.
The service is intended to be a high performance and low footprint applicaƟon; therefore, C++was
chosen for its unique combinaƟon of performance and high-level features. Boost further extends
C++ with cross-plaƞorm implementaƟons of addiƟonal features. Notably a high-performance
event-driven socket I/O library is included in Boost.
The service oversees encrypƟng/decrypƟng and forwarding outgoing connecƟons on the client
side.
SElink™ service is configured by means of an external GUI applicaƟon, which can send some com-
mands to the service to perform operaƟons or retrieve informaƟon.
The commands are hereby listed:

• reload: reload the filter rules file and update the filter rules

• status: query the device and service status
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• discover: discover all connected devices, returning a list of their paths and serial numbers

• set_device: select a device by its serial number and pass its password

• reset: disconnect from the device and clear the device configuraƟon.

The service creates a named pipe at startup, on which it listens for connecƟons from the GUI. For
each connecƟon to the named pipe, a single request packet is processed and a response packet
is returned, then the pipe is disconnected.
A thread is devoted to inter-process communicaƟon only. All the I/O operaƟons for the named
pipe are handled asynchronouslywithWindows overlapped I/O funcƟons, and all wait operaƟons,
in addiƟon to waiƟng on I/O compleƟon with a Ɵmeout, also wait on a stop event. This makes
it possible to immediately stop the inter-process communicaƟon thread when the service closes,
without resorƟng to polling.
SElink™ service can register itself as a Windows service, and be managed through the Windows’
services interface.
Running a process as a Windows service implies that:

• It runs as the SYSTEM user

• It can be configured to run at startup

• It can be enabled, disabled, started, stopped or deleted from a simple command line inter-
face or from the Windows Management Console.

Summarizing, starƟng SElink™ is as simple as issuing the following commands to the Windows
command prompt:

sc start selinksvc
net start selinkflt

7.5 SElink™ GUI

An important part of the project is allowing users, with liƩle prior knowledge of cryptography and
programming, to use SElink for the pracƟcal purpose of encrypƟng network traffic.
Another point for the GUI is the necessity to provide an interacƟve dialog window to log into the
SElink™ , and avoid leaving the passphrase in the command line or configuraƟon file.
The GUI could not be included within the service, because there is no convenƟonal way of pre-
senƟng a GUI to the user while running as the SYSTEM user. A simple GUI, here described briefly,
has been developed for the cited reasons.
The Windows PresentaƟon Framework (WPF) is a framework for Windows GUI applicaƟons, part
of the .NET framework. It was chosen for the development of SElink™ GUI because of its over-
all features and good integraƟon with the operaƟng system. The choice was not restricted to
cross-plaƞorm framework, because the applicaƟon is specifically made for the SElink client-side
soŌware, running on Windows.
Among the .NET and WPF features that were used there are:

• Windows tray icon funcƟonaliƟes

• JSON parser

• Customizable DataGrid GUI component.
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When the applicaƟon is run, it creates a clickable icon in the tray area, which is used to access the
configuraƟon dialogs. There are two main dialogs: the device selecƟon dialog and the filter rules
dialog, explained in the next SecƟons (Figure 24).

Figure 24: Tray icon interface.

For the service to connect and work properly, the user must select a suitable device (Figure 25).

Figure 25: Device selecƟon interface.

A passphrase is required to unlock the device (Figure 26).

Figure 26: Unlocking the device.

AŌer confirming the passphrase, the outcome of the operaƟon is shown via balloon noƟficaƟon
(Figure 27). The GUI does not directly perform any operaƟon on the devices. Instead it uses the
service by sending commands through a named pipe.
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Figure 27: Login noƟficaƟon.

The filter rules window provides an easy way to edit the filter rules configuraƟon file, minimizing
the risk of making mistakes or producing an invalid configuraƟon. Based on the DataGrid WPF
component, it allows adding, removing and ediƟng the filter rules. Rules are processed in order
and only the first matching rule is considered.
Therefore, there is the possibility for a rule to cover one of the following rules, which means that
any enƟty matching the second rule also matches the first rule, so the second rule will never be
used. The inserƟon of amasking rulemay ormay not be intenƟonal, therefore a warning is shown
if there are any masked rules, and which is the first masking rule for each masked rule (Figure 28).

Figure 28: Filter rules editor.

All fields within each rule are validated, to prevent creaƟng an invalid configuraƟon. Each row of
the grid shows a relevant error if it does not pass a validaƟon rule (Figure 29).
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Figure 29: Filter rules editor highlights an invalid rule.

As soon as the rules are applied, the rules file is wriƩen and the service is signaled to reload the
file.

7.6 Running the provided demo

The main goal of this demo is to show of a Windows soŌware (gateway) that transparently inter-
cepts and encrypts/decrypts TCP streams, and its server-side counterpart, a cross-plaƞorm proxy
that intercepts and decrypts/encrypts the streams.
This soŌware use the Layer1 API of the SEcube™ open plaƞorm to perform the encrypƟon step.
The soŌware can encrypt network streams originaƟng from any applicaƟon transparently, with-
out the need to modify or recompile the applicaƟon.
In addiƟon, the final product is very be user-friendly and configurable by means of a graphical
user interface, both client-side and server-side, and easy to install and capable of running in back-
ground silently, requiring minimum user aƩendance aŌer setup.
To establish a secure communicaƟon, a properly configured host running the client soŌwaremust
iniƟate a connecƟon towards a properly configured host running the server soŌware.
In most cases the user will only need to install and configure the client soŌware.

7.6.1 Requirements

Client requirements:

• 64-Bit Windows 10

• SEcube™ device26.

Server requirements:

• Any of:
– Windows 7 or newer27.
– Linux

• SEcube™ device.

7.6.2 The Client soŌware

The only prerequisite is to install the client soŌware is the Windows C++ RunƟme library, freely
accessible on-line28.
There are three components to be installed for the soŌware to operate properly:
26SElink™ can be used without a SEcube™ device, for tesƟng purposes or custom configuraƟons.
27Daemon mode not yet supported on Windows.
28https://www.microsoft.com/it-it/download/details.aspx?id=48145

https://www.microsoft.com/it-it/download/details.aspx?id=48145
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• SElink™ driver

• SElink™ service

• SElink™ GUI.

The provided setup executable installs all the components at once.
Since the driver is not signed, Windows 10 needs to run in Test Mode to install the driver.
To do so:

1. Open an administrator command prompt and execute the following command:
bcdedit /set TESTSIGNING ON
Warning: this command disables driver signature check enforcement on Windows.

2. Reboot

Finally, run selink-setup.exe.
AŌer the setup procedure, the SElink™ client soŌware can be easily configured through the GUI
applicaƟon. You can access the device configuraƟon window by leŌ-clicking the tray icon and
choosing Device. The status of the service and the device is shown on the top.
To connect a SEcube™ device:

1. Select a suitable device from the drop-downmenu. If a device does not show up, press the
refresh buƩon on the right.

2. Press the Connect buƩon

3. Insert your user pin and click the Login buƩon

4. The device configuraƟonwindow should disappear, and a noƟficaƟon should appear shortly
aŌer.

To disconnect it, it is simply needed to press the Disconnect buƩon.
You can access the filter rules configuraƟon window by leŌ-clicking the tray icon and choosing
Filter rules.
Filter rules are used to manage outgoing connecƟons, to decide which will be encrypted and with
which key. A filter rule is made of:

• A condiƟon to select connecƟons based on some parameters:
– Executable path: full path to the source applicaƟon’s executable file
– DesƟnaƟon IP: desƟnaƟon IP address
– First port, Last port: desƟnaƟon port range.

• An acƟon to be taken with the matching connecƟons:
– AcƟon: one of Allow, Block or Encrypt
– Key: the key ID to be used when encrypƟng.

In order for a condiƟon to match a connecƟon, all the parameters must match. An empty param-
eter stands for any value.
Within the GUI you may define a list of filter rules, to select different acƟons for different con-
necƟons. For example, the user might assign a different encrypƟon key to each applicaƟon you
are going to use. Note that the order in which rules appear is important: the first matching rule
is chosen, regardless of the following rules. If a connecƟon does not match any rule, it is allowed
(not encrypted) by default.
You can create a new rule by doing any of the following:
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• Right-click on the grid and select Insert aŌer or Insert before

• Fill the last row of the grid

The rules’ fields must comply with the following constraints:

• DescripƟonmust be shorter than 64 characters

• DesƟnaƟon IPmust be a valid ipv4 or ipv6 address

• First port and last portmust describe a valid port range
– first port, last port must be both natural numbers lesser than 65536, or both empty
– if not empty, first port must be lesser than or equal to last port

• The keymust be
– An integer number if the acƟon is Encrypt
– Empty if the acƟon is Allow or Block

Tip: you can override the default acƟon by adding a rule with empty condiƟon fields at the end of
the list.
Drag and drop a row over the desired posiƟon to move the corresponding rule. Right-click on a
row and select Delete to delete it.

7.6.3 Server side

To install the needed soŌware on server side it is sufficient to:

1. Install g++ and the boost development libraries for your system29

2. Change directory into the SElink™ source code directory and build the SElink™ gateway:

# make

3. Install
• Default installaƟon

# make install

The soŌware and configuraƟon files will be installed in ”/opt/selink/”
Itwill be configured to runwithout a SEcube™device, using the keys from”/opt/selink/keys.json”
The systemd unit will be installed in ”/usr/lib/systemd/system/selinkgw.service”

• Custom installaƟon
– Copy ”bin/selinkgw” and any needed configuraƟon file to a target directory
– Customize the “system” unit in “example/selinkgw.service” and copy it to the ap-

propriate locaƟon for the system.

The command to start the daemon is

# systemctl start selinkgw

To stop it launch

# systemctl stop selinkgw

29e.g., pacman −S base−devel boost on Arch Linux
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The configuraƟon is made up of a simple list of port mappings. Each entry contains:

• A descripƟon text

• The port on which encrypted connecƟons will be accepted

• The host and port to which connecƟons will be redirected, unencrypted

• The key id to use for encrypƟon.

You may configure the SElink gateway in two ways:

• Using the web UI

• Using the configuraƟon file.

To use the web UI:

1. Install python3, python3 modules boƩle, and jsonschema on your system

2. cd into the gwconfig directory and run the Web UI as root (assumes a default installaƟon)

# python3 gwconfig.py −−use−token

3. Open the link on the terminal output with a web browser

Within the web UI you can add a new rule or delete an exisƟng one.
To add a new rule, press Add and insert the rule. The mappings’ fields must comply with the
following constraints:

• Listen port and Redirect port must be natural numbers lesser than 65536

• Redirect host must be a valid ipv4 or ipv6 address.

To delete a rule, press the trash icon in the last column of the row to delete. AŌer each modi-
ficaƟon, please remember to press the Apply buƩon. The new configuraƟon will be saved and
applied immediately.
Vice versa, it is possible to edit directly the configuraƟon file as follows:

1. Edit the configuraƟon file with a text editor. Please refer to “example/selinkgw.json” for an
example file

2. Signal the daemon:

# systemctl reload selinkgw

7.6.4 Advanced configuraƟon

The driver can be configured to only filter connecƟons with desƟnaƟon ports within a port range,
and allow anything else, regardless of whether the service is running.
The driver configuraƟon is stored in the following registry key: HKEY_LOCAL_MACHINE\SYSTEM
\CurrentControlSet\Service\selinkflt\Parameters.

Name Type DescripƟon
PortFirst REG_DWORD First port of filtered port range
PortLast REG_DWORD Last port of filtered port range
ServicePort REG_DWORD Port on which the service is listening for redirected connecƟons
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As a convenƟon on file paths, any path starƟng with “:” is relaƟve to the executable’s path. For
example, if the executable is located in “C:/SElink/selinksvc.exe”, then “:selinksvc.json” points to
“C:/SElink/selinksvc.json”.
Any relaƟve path is relaƟve to the current working directory, which depends on how the process
was created.

INI files
Command line opƟons for the SElink™ service and SElink™ gateway may be specified either by
passing them as parameters on the command line, or seƫng them into dedicated configuraƟon
files:

• For SElink™ service, create a file named “selinksvc.ini” in the same directory as the exe-
cutable.

• For SElink™ gateway, create a file named “selinkgw.ini” in the same directory as the exe-
cutable.

An example of a valid “.ini” configuraƟon file is:

provider=soft
keys=:keys.json

Please note that only long opƟons (i.e., no short keys) are allowed in the configuraƟon file.

SElink™ service opƟons

OpƟon Value DescripƟon
--help, -h (none) Show a help message
--log, -l log file path Set the locaƟon of the log file. De-

faults to “:selinksvc.log” when running
as service, or none when running in
foreground.

--config, -c configuraƟon file path Set the locaƟon of the filter rules
configuraƟon file. Defaults to
“:selinksvc.json”.

--provider, -p provider type Set the provider type. Can be soft or
secube.

--keys, -k path to key collecƟon file Set the keys. Only required if the
provider is of type soft.

--port, -w port Set the driver connecƟon redirecƟon
port.

--foregrou (none) Run in foreground instead of running
as a service.
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SElink™ gateway opƟons

OpƟon Value DescripƟon
--help, -h (none) Show a help message
--log, -l log file path Set the locaƟon of the log file. Defaults

to ”/var/log/selinkgw.log” when run-
ning as service, or none when running
in foreground.

--config, -c configuraƟon file path Set the locaƟon of the filter rules
configuraƟon file. Defaults to
“:selinkgw.json”.

--provider, -p provider type Set the provider type. Can be soft or
secube.

--keys, -k path to key collecƟon file Set the keys. Only required if the
provider is of type soŌ.

--serial-number, -s path to key collecƟon file Set the keys. Only required if the
provider is of type soft.

--pin, -z path to pin file The user pin to log into the SEcube™
device will be read from the specified
file. Only required if the provider is of
type secube.

--foreground, -f (none) Run in foreground instead of running
as a daemon.

SElink™ gateway web UI opƟons

OpƟon Value DescripƟon
--help, -h (none) Show a help message.
--host host Host on which the web UI server will listen.
--port port Port on which the web UI server will listen.
--config, -c configuraƟon path Path to gateway configuraƟon file.
--pidfile pidfile path Path to gateway pidfile.
--use-token (none) Generate a random token to restrict access to the

web UI.
--debug (none) Enable debug mode.

7.6.5 The APIs commented

SElink™uses the connecƟon redirecƟon feature inWFP, available for redirecƟng enƟre TCP streams
to a different desƟnaƟon, possibly for filtering. Filtering in WFP is done by registering callback
funcƟons (named Callouts) intercepƟng the desired operaƟons (e.g., connect, send, receive) at
the desired layer.
Within the driver there are two callouts: one for the ipv4 connect redirecƟon layer
(FWPM_LAYER_ALE_CONNECT_REDIRECT_V4) and one for the ipv6 connect redirecƟon layer
(FWPM_LAYER_ALE_CONNECT_REDIRECT_V6), which means that all connecƟon requests are
intercepted. A filter specificaƟon is associated to the callout, restricƟng the intercepted requests
to TCP connecƟons on a user-defined port range.
Resources from theMicrosoŌ website, such the Bind or Connect RedirecƟon feature documenta-
Ɵon and the sample driver projects, have been taken as reference for the implementaƟon of the
driver.
Any intercepted connecƟon request is redirected to the local proxy, that will possibly encrypt the
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connecƟon and forward it to the intended desƟnaƟon. First, within the callout, a redirect con-
text is filled with some data that will be useful for the user-space filter. The redirect context is a
WFP feature to aƩach arbitrary data to the connecƟon request, which can then be retrieved by a
different applicaƟon.
For later applying filter rules, the following parameters are added to the redirect context:

• Original source and desƟnaƟon address and port

• Process ID of the process which generated the request.

//Fill the redirect context
ConnectRequest−>localRedirectContextSize = REDIRECT_CONTEXT_SIZE

;
RedirectContext = (SOCKADDR_STORAGE*)ConnectRequest−>

localRedirectContext;
RedirectContext[0] = ConnectRequest−>localAddressAndPort;
RedirectContext[1] = ConnectRequest−>remoteAddressAndPort;
RtlZeroMemory(&RedirectContext[2], sizeof(SOCKADDR_STORAGE));
ProcessId = (UINT64)InMetaValues−>processId;
RtlCopyMemory(&RedirectContext[2], &ProcessId, sizeof(UINT64));

Then, the desƟnaƟon address and port are changed within the request headers, which effecƟvely
causes the socket to connect to a local service instead of its original desƟnaƟon. WFP also re-
quires the target process ID to be set for local redirecƟon, so the designated field is filled with the
service’s PID.

//Redirect to localhost
INETADDR_SETLOOPBACK((PSOCKADDR)&(ConnectRequest−>

remoteAddressAndPort));
INETASSR_SETPORT((PSOCKADDR)&(ConnectRequest−>

remoteAddressAndPort), RtkUshortByteSwap(Globals, ServicePort
));

ConnectRequest−>localRedirectHandle = Globals.RedirectHandle;
ConnectRequest−>localRedirectTargetPID = Globals.

RedirectTargetPID;
FwpsApplyModifiedLayerData(ClassifyHandle, (PVOID)ConnectRequest

, 0);

7.7 SElink™ APIs

This SecƟon provides a brief overview about the SElink™ APIs.
For more details about their implementaƟon, please refer to the Doxygen-based documentaƟon.

void SElink_buffer_init(SElink_buffer* buf)

This funcƟon iniƟalizes a buffer object to an empty buffer.

void SElink_buffer_ensure(SElink_buffer* buf, size_t newsize)

This funcƟon ensures the capacity for SElink™ buffer.
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void SElink_buffer_grow(SElink_buffer* buf, size_t required)

This funcƟon ensures capacity for SElink™ buffer, which is expanded to the desired size (must be
a power of 2).

void SElink_buffer_free(SElink_buffer* buf)

This funcƟon disposes of the SElink™ buffer.

void SElink_raw_init(SElink_raw* sr)

This funcƟon iniƟalizes the SElink™ raw context.

void SElink_raw_reserve_keys(SElink_raw* sr, size_t nkeys)

This funcƟon reserves the memory space for keys buffer.

void SElink_raw_reserve_algorithms(SElink_raw* sr, size_t
nalgorithms)

This funcƟon reserves the memory space for algorithms buffer.

void SElink_raw_add_key(SElink_raw* sr, uint32_t id, const
uint8_t* fingerprint)

This funcƟon adds a key to the SElink™ raw context.

void SElink_raw_add_algorithm(SElink_raw* sr, uint32_t id, const
uint8_t* fingerprint)

This funcƟon adds an algorithm to the SElink™ raw context.

void SElink_raw_clear(SElink_raw* sr)

This funcƟon disposes of keys and algorithms buffers.

void SElink_raw_d1_write(SElink_raw* sr, size_t* len, uint8_t*
data)

This funcƟon writes D1 packets.

bool SElink_raw_d1_get_size(SElink_raw* sr, size_t len, const
uint8_t* data, size_t* size)

This funcƟon retrieves the size of D1 packets.

bool SElink_raw_d1_read(SElink_raw* sr, size_t len, const
uint8_t* data)

This funcƟon reads D1 packets.

bool SElink_raw_d1_match(SElink_raw* sr, size_t len, const
uint8_t* data)

This funcƟon finds a match in D1 packets.

void SElink_raw_d2_write(SElink_raw* sr, size_t* len, uint8_t*
data)

This funcƟon writes D2 packets.

bool SElink_raw_d2_read(SElink_raw* sr, size_t len, const
uint8_t* data)

This funcƟon reads D2 packets.
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void SElink_raw_s1_write(SElink_raw* sr, size_t* len, uint8_t*
data)

This funcƟon writes S1 packets.

bool SElink_raw_s1_read(SElink_raw* sr, size_t len, const
uint8_t* data)

This funcƟon reads S1 packets.

bool SElink_raw_s1_match(SElink_raw* sr, size_t len, const
uint8_t* data)

This funcƟon finds a match in S1 packets.

void SElink_raw_h_write(SElink_raw* sr, uint8_t* header, size_t
data_size)

This funcƟon writes data packet headers.

void SElink_raw_h_read(SElink_raw* sr, const uint8_t* header,
size_t* data_size)

This funcƟon reads data packet headers.

void SElink_raw_fingerprint(const uint8_t* salt, size_t len,
const uint8_t* data, uint8_t* fingerprint)

This funcƟon generates raw fingerprints.

uint16_t SElink_raw_secube_import(SElink_raw* sr, se3_session* s
, uint16_t key_size, uint16_t algo_type)

This funcƟon imports keys and algorithms from the device.

size_t SElink_raw_packet_size(size_t data_size)

This funcƟon retrieves the expected packet size.

void SElink_init(SElink* ctx, se3_session* s)

This funcƟon iniƟalizes the SElink context.

void SElink_destroy(SElink* ctx)

This funcƟon destroys the SElink context.

uint16_t SElink_duplex_write_request(SElink* ctx, SElink_buffer*
buf)

This funcƟon writes duplex requests.

uint16_t SElink_duplex_get_request_size(SElink* ctx,
SElink_buffer* buf, size_t* request_len)

This funcƟon retrieves the length of duplex request packets.

uint16_t SElink_duplex_reply(SElink* ctx, SElink_buffer* buf)

This funcƟon replies to duplex requests.

uint16_t SElink_duplex_read_response(SElink* ctx, SElink_buffer*
buf)

This funcƟon reads duplex responses.
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uint16_t SElink_simplex_write_invite(SElink* ctx, SElink_buffer*
buf)

This funcƟon writes simplex invites.

uint16_t SElink_simplex_read_invite(SElink* ctx, SElink_buffer*
buf)

This funcƟon reads simplex invites.

uint16_t SElink_write(SElink* ctx, size_t data_len, const
uint8_t* data, SElink_buffer* buf)

This funcƟon writes data packets.

uint16_t SElink_read_header(SElink* ctx, size_t data_len, const
uint8_t* data, size_t* remaining_bytes)

This funcƟon reads data packets’ headers.

uint16_t SElink_read(SElink* ctx, size_t data_len, const uint8_t
* data, SElink_buffer* buf)

This funcƟon reads data packets.
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8 The SEkey™ library

SEkey™ is a KeyManagement System (KMS) specific for the SEcube™ Open Security Plaƞorm. The
target of SEkey™ is to allow an easy and secure management of encrypƟon keys to be used by
applicaƟons based on the SEcube™ device. SEkey™ supports the secure generaƟon, distribuƟon,
and usage of encrypƟon keys in domains characterized by mulƟple users who need to share sen-
siƟve data to be protected with the SEcube™ device.

8.1 Key Management System

A Key Management System (KMS) is a purely soŌware or hybrid hw-sw system with the aim of
handling, administraƟng and protecƟng cryptographic keys. A KMS must provide several func-
ƟonaliƟes, such as the management of the lifecycle of keys, including their generaƟon, usage,
storage and deleƟon. Other essenƟal features of a KMS are the distribuƟon of the keys to autho-
rized enƟƟes and the protecƟon of the keys while they are stored on physical devices.
According to the NaƟonal InsƟtute of Standards and Technology (NIST)30: “The proper manage-
ment of cryptographic keys is essenƟal to the effecƟve use of cryptography for security. Keys
are analogous to the combinaƟon of a safe. If a safe combinaƟon is known to an adversary, the
strongest safe provides no security against penetraƟon. Similarly, poor key management may
easily compromise strong algorithms.”31.
EncrypƟon keys must be protected, otherwise they become useless: encrypƟon keys are only as
good as the security used to protect them. In order to implement a well-designed KMS, a set of
policies, procedures and components (both hardware and soŌware) must be selected.

8.2 EncrypƟon Keys

EncrypƟon keys used within the SEcube™ Open Security Plaƞorm are always dedicated to sym-
metric encrypƟon algorithms, such as AES-256. Symmetric encrypƟon algorithms use the same
key both for encrypƟon and decrypƟon, they are fast and resilient against quantum cryptopgra-
phy aƩacks but they require both parƟes to know the same encrypƟon key.
SEkey™ is able to manage any type of encrypƟon key, independently from its length, algorithm
and usage. However, since the open source SDK of the SEcube™ supports only the AES-256 al-
gorithm, the APIs of the KMS have been wriƩen and tested having in mind the usage of 256 bit
symmetric keys.
Each key is characterized by several aƩributes:

• ID: a unique value that is used to idenƟfy the key within the KMS, the format of the ID is
‘K123‘ where ‘123‘ can be replaced by any number between 0 and 232 − 1;

• label: a human-readable text string describing the key (i.e. Key June 2020 Customer Care
Department);

• owner: the ID of the owner of the key, meaning the enƟty to which the key is related (i.e.
a key may be reserved to be used by a specific group of users, so the group is the owner of
the key);

• status: the current state of the key (i.e. acƟve, suspended, deacƟvated, compromised,
destroyed, etc.);

• type: the type of the key (i.e. symmetric data encrypƟon);

30https://www.nist.gov
31https://nvlpubs.nist.gov/nistpub/SpecialPublications/NIST.SP.800-57pt1r4.pdf

https://www.nist.gov
https://nvlpubs.nist.gov/nistpub/SpecialPublications/NIST.SP.800-57pt1r4.pdf


The SEcube™ Open Security Plaƞorm
Document ClassificaƟon: Public

Page 73 of 130
Release: 010

• algorithm: which cryptographic algorithm is coupled to the key (i.e. AES-256);

• length: number of bit composing the key;

• generaƟon: date and Ɵme at which a key is generated;

• acƟvaƟon: date and Ɵme at which a key is acƟvated;

• expiraƟon: date and Ɵme at which a key is expired;

• deacƟvaƟon: date and Ɵme at which a key is deacƟvated;

• suspension: date and Ɵme at which a key is suspended;

• compromise: date and Ɵme at which a key is compromised;

• destrucƟon: date and Ɵme at which a key is destroyed;

• cryptoperiod: Ɵme span during which a key can be used both for encrypƟon and decryp-
Ɵon, it is a Ɵme interval that is added to the acƟvaƟon Ɵme to compute the expiraƟon Ɵme
of the key.

During its lifecycle, a key can go through many states, from its generaƟon to its destrucƟon. The
state of a key determines the spectrum of usage of the key, for example a key that is not acƟve
cannot be used to encrypt data. Figure 30 shows the key state diagram and the possible state
transiƟons. NoƟce that these transiƟons are not mandatory by any means, in fact the only state
that is always assumed by a key is the Pre-AcƟve because that is set by default during the key
generaƟon funcƟon. Once a key is created, all other transiƟons are opƟonal (i.e. a key may stay
forever in the default state while another one may go through all states).
NoƟce that a key can always be set to the compromised or destroyed state, this is required for
security reasons.

Figure 30: Key State diagram.

• Pre-acƟve: a key in this state cannot be used neither for encrypƟon nor for decrypƟon. This
is the default state for every new key.

• AcƟve: a key in this state can be used for encrypƟon and decrypƟon. This implies that it
was acƟvated in the past and that it will be deacƟvated in future.

• Suspended: a key can be in this state only if it was acƟve and then itwas suspended for some
reason. A suspended key can be used for decrypƟon but not for encrypƟon, it can also be
acƟvated again. NoƟce that the Ɵme during which the key is suspended sƟll contributes to
the Ɵme that determines the expiraƟon of the key.
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• DeacƟvated: a key in this state cannot be used for encrypƟon but only for decrypƟon of old
files once encrypted with the key when it was acƟve. NoƟce that a key may be set to the
deacƟvated state even without being acƟve in the past, on the other hand a key which is
acƟve will be set to deacƟvated once it reaches its expiraƟon Ɵme.

• Compromised: a key in this state may have been stolen by some aƩacker or may have been
leaked outside of SEkey™ . This key is not secure anymore, therefore it must not be used for
encrypƟon; it should be used as soon as possible to decrypt the files which were encrypted,
in order to encrypt them again with a new, secure key. Old files related to the compromised
key should be deleted.

• Destroyed: a key in this state is not part of SEkey™ anymore. Its metadata are sƟll retained
by SEkey™ ; however, the actual key value has been deleted and cannot be recovered so all
files which are sƟll encrypted with a destroyed key are lost forever.

8.3 The architecture of SEkey™

SEkey™ is distributed among mulƟple SEcube™ devices: it is composed by one Admin’s SEcube™ ,
and one SEcube™ for each user of the system. The Admin’s SEcube™ can be seen as a server and
the other SEcube™ devices as clients. However, SEkey™ is not a centralized KMS where a server
handles requests coming from the users. SEkey™ reverses the tradiƟonal client/server approach,
the administrator in fact automaƟcally pushes data to a predefined locaƟon while the users fetch
these data according to their needs.

Figure 31: SEkey™ context diagram.

Therefore, SEkey™ is distributed also in terms of data. The KMS is focused not only on the en-
crypƟon keys but also on other metadata that carry informaƟon about the keys, the users and so
on. These data are mainly stored inside the SEcube™ device belonging to the administrator, then
they are automaƟcally replicated (with the push and fecth mechanism menƟoned above) on the
devices of the users. The data distribuƟon mechanism is totally transparent to the administrator
and to the users, the greatest advantage is that the users are automaƟcally providedwith the data
they need. Therefore, the users can exploit the KMS locally and ‘offline‘, resorƟng exclusively to
the informaƟon they have on their personal SEcube™ , without the need of contacƟng an exter-
nal server. NoƟce that the administrator provides the data to the users according to the ‘Least
Privilege‘ principle 32.
Each SEcube™ involved in SEkey™ adopts the following approach to store the data belonging to
the KMS:

• the microSD card provided with the SEcube™ board stores an encrypted SQL database (im-
plemented with SQLite and SEfile™ ) containing most of the metadata of the KMS (informa-
Ɵon about users, groups, keys, etc.);

• the internal flash memory of each SEcube™ stores, as clear-text, the actual values of the
encrypƟon keys managed by SEkey™ .

32https://nvlpubs.nist.gov/nistpubs/Legacy/SP/nistspecialpublication800-57p2.pdf

https://nvlpubs.nist.gov/nistpubs/Legacy/SP/nistspecialpublication800-57p2.pdf
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This data parƟƟoning scheme is valid both for the administrator and for the users. The only dif-
ference among them is that the SEcube™ of the administrator stores everything that is managed
by SEkey™ (every key and every metadata), while the SEcube™ devices of the users only store a
fracƟon of those data, according to the ‘Least Privilege‘ principle (i.e. if a user is not allowed to
access to a certain key, the value of that key will not be stored on his SEcube™ ).

8.4 Administrator and users of SEkey™

There are only two types of actors in SEkey™ : administrator and users. There is only one admin-
istrator, his job is to manage the KMS using specific APIs, for example he can add/delete users,
add/delete/modify groups, add/delete keys and so on. On the other hand, the users simply fetch
the changes applied by the administrator to the system and store them in their KMS configuraƟon;
then they can use a reduced set of APIs to perform operaƟons such as retrieving a key, retrieving
the list of the users belonging to a certain group and so on.
NoƟce that the roles of the administrator and of the users cannot overlap, meaning that the ad-
ministrator is not a user of SEkey™ and a user cannot be the administrator. However, it is clear
that the role of the administrator must be carried on by a real person who manages the KMS
according to specific needs (i.e. the IT security manager of a company); noƟce that this person
cannot act as administrator and user at the same Ɵme using the same SEcube™ device. If the ad-
ministrator of SEkey™ also needs to be a user of the KMS, then he/shemust possess two different
SEcube™ devices and, ideally, two different host computers. The first pair SEcube™ - host is used
to work as administrator, the second pair is used to work as a user of the system.
One of themost important tasks performed by the administrator is the physical iniƟalizaƟon of the
SEcube™ devices of the users. Each SEcube™ can be iniƟalized using an API provided by SEkey™
, so the administrator sets two PIN codes that must be unique to that device and that are used
to access to it with admin privilege or user privilege. NoƟce that the administrator of SEkey™will
be able to store and see all the PINs of all SEcube™ devices, on the other hand each user must re-
ceive only the PIN that allows him to access to his SEcube™ with the lowest privilege. Depending
on the PIN that is used to access to the SEcube™ , the device will expose different funcƟonaliƟes
and SEkey™will enable only selected APIs (i.e. to prevent the possibility of data tampering by the
users).

8.5 Logical overview about users, groups, and keys of SEkey™

The goal of SEkey™ is to allow the secure management and sharing of encrypƟon keys between
users who have a personal SEcube™ device and belong to a certain environment. Within this
context, users can be split in several groups, a specific security policy is associated to each group.
This approach is useful to replicate the hierarchies found in real-world scenarios, for example in a
company where the employees are divided into departments. NoƟce that each group may have
zero, one or mulƟple users, a specific user may belong to several groups; moreover, groups may
overlap. The security policy associated to each group determines fundamental parameters of that
group, in parƟcular:

• the maximum number of keys to which the group can be related (each group owns a set of
keys);

• the algorithm used by the keys of the group (so that a group may implement a more rigid
security policy with respect to another one);

• the default cryptoperiod of the keys of the group (which is adopted if a specific key does
not have a specific cryptoperiod or if its cryptoperiod is longer than the default one).
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The concept of the group is strictly related to the one of encrypƟon keys. SEkey™ , in fact, is
designed such that a single user is never able to access directly to a key, meaning that users cannot
‘own‘ a key. Keys are related to the groups, not to the users, according to the following rules:

• the groups are the owners of the keys

• a user can use a key only if he/she is a member of the group that owns that key

• users who are member of the same group share all the keys of that group

• each group may own zero, one or mulƟple keys

• each groupmay own as many keys as the corresponding parameter specified by its security
policy

• each key is owned by only one group

• a key cannot be owned by two or more groups, not even in different moments

• the ownership of a key cannot be transferred from a group to another group

• if a group is destroyed, all the keys ownedby that groupbecome ‘zombie‘ keys (they become
unusable and their owner is set to ‘zombie‘ but they are not destroyed because they may
sƟll be required to decrypt old data).

In conclusion, the logical implementaƟon of SEkey™ is quite simple. Users are split in groups with
different dimensions and security policies, to each group is associated a specific set of encrypƟon
keys. A user can access only to the keys associated to the groups to which he/she belongs, there-
fore users who have at least one group in common also have common keys (symmetric encrypƟon
keys) that can be used to encrypt data to be shared among them (i.e. real-Ɵme communicaƟons
or files). NoƟce that users can also encrypt data for private usage and not only for data sharing,
they simply need to belong to a group with a single member: themselves.
The interconnecƟon of users, groups, and keys allows us to implement security features based
on the dimension of each group. The idea is that a smaller group is more secure because less
people have access to the keys of that group; according to this assumpƟon, SEkey™ offers to its
users APIs to retrieve the most secure key to be used in a given scenario (i.e. to encrypt data for
private usage, to encrypt a real-Ɵme communicaƟon with another user, to encrypt a file to be
shared with an enƟre group or with mulƟple users, etc.).

Figure 32: SEkey™ logical overview.
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8.6 Use Cases

8.6.1 Security Admin’s use cases

Among all the management use cases, the ones related to the creaƟon of new objects (groups,
users, keys) are the most complete. For this reason, they are described here, while the ones re-
lated to the modificaƟon and eliminaƟon of objects, that are similar and simpler, are not shown.

Use case UC1: Add Group
ApplicaƟon: SEkey™
Actor: Security Admin
Pre-condiƟons: Security Admin is already authenƟcated and logged in.
Post-condiƟons: A new group is added to SEkey™ .
Main scenario:

1. Security Admin calls the API to add a new group to the KMS, providing the required param-
eters (i.e. the name of the group, the security policy, etc.);

2. The API validates the correctness of the request and checks for collisions in the current KMS
configuraƟon (i.e. the administrator requested a group ID that is already in use);

3. If the request of the administrator is valid, the API modifies the database containing the
metadata of SEkey™ adding a new group that is empty and is not owner of any key;

4. A suitable result code is returned to the administrator, who then can assess if the operaƟon
was completed or not.

Use case UC2: Add User
ApplicaƟon: SEkey™
Actor: Security Admin
Pre-condiƟons: Security Admin is already authenƟcated and logged in
Post-condiƟons: A new user is added to SEkey™ . An encrypted update file is prepared for the
SEcube™ of the new user.
Main scenario:

1. Security Admin calls the API to add a new user to the KMS, providing the required param-
eters (i.e. the name of the user, the desired ID, etc.);

2. The API validates the correctness of the request and checks for collisions in the current KMS
configuraƟon (i.e. the administrator requested a user ID that is already in use);

3. If the request of the administrator is valid, the API modifies the database containing the
metadata of SEkey™ adding a new user who sƟll does not belong to any group;

4. A suitable result code is returned to the administrator, who then can assess if the operaƟon
was completed or not.

Use case UC3: Add Key
ApplicaƟon: SEkey™
Actor: Security Admin
Pre-condiƟons: Security Admin is already authenƟcated and logged in
Post-condiƟons: A new key is added to SEkey™ . A specific encrypted update file is prepared for
the SEcube™ of each user belonging to the group owner of the new key.
Main scenario:
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1. Security Admin calls the API to add a newkey to the KMS, providing the required parameters
(i.e. the name of the key, the desired ID, the group owner of the key, etc.);

2. The API validates the correctness of the request and checks for collisions in the current KMS
configuraƟon (i.e. the administrator requested a key ID that is already in use);

3. If the request of the administrator is valid, the API modifies the database containing the
metadata of SEkey™ adding a new key;

4. AŌer storing the metadata of the new key in the encrypted database, the API issues a re-
quest to the firmware of the SEcube™ to internally generate a key of the specified length
using the True Random Number Generator of the SEcube™ ;

5. The SEcube™ of the administrator generates the key using the TRNG, then the key is stored
inside the flash memory of the SEcube™ without being exposed outside of the device;

6. The API checks if the key was successfully generated; if so then it prepares a specifically
encrypted update file for each member of the group that has been specified as owner of
the new key, inserƟng into the update file the metadata of the key;

7. The API must also insert the actual key value inside the update, in order to distribute the
key to the enƟtled users. This is done issueing a request to the firmware of the SEcube™
which returns to the API the value of the new key, wrapped using AES-256 with another
encrypƟon key that is symmetric and unique for each pair of user and administrator;

8. The API, without having access to the actual value of the new key because it is encrypted,
writes it into the encrypted update file for each involved user (noƟce the double encrypƟon
layer around the value of the key, the first one provided with the wrapping of the SEcube™
and the second one provided by SEfile™ );

9. A suitable result code is returned to the administrator, who then can assess if the operaƟon
was completed or not.

8.6.2 User’s Use Cases

The purpose of the user is to exploit group keys in order to encrypt and decrypt data to be ex-
changed with other users. A user can decide to encrypt some data by choosing as recipient an-
other user, an enƟre group to which he belongs or a set of users.

Use case UC4: Encrypt Data
ApplicaƟon: SEkey™
Actor: User
Pre-condiƟons: User is already authenƟcated and logged in
Post-condiƟons: SEkey™ returns to the user the ID of the key to be used for encrypƟon
Main scenario:

1. TheUser calls one of the APIs of SEkey™ to retrieve themost secure key to be used providing
the recipient(s) (i.e. a single user, unicast communicaƟon);

2. SEkey™ checks the validity of the requests, searches the encrypted database for the small-
est group containing both the sender and the receiver, then looks for the acƟve key (i.e.
usable for encrypƟon) with the shortest cryptoperiod (assuming that a shorter cryptope-
riod implies higher security);
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3. If a suitable key is found, the API returns the ID of that key to the user, otherwise an error
code is returned;

4. The user checks the return code and, if possible, specifies that key ID as a parameter to the
encrypƟon API to encrypt the required data.

Use case UC5: Retrieve known users
ApplicaƟon: SEkey™
Actor: User
Pre-condiƟons: User is already authenƟcated and logged in
Post-condiƟons: SEkey™ returns to the user the list of known users
Main scenario:

1. The User calls the API of SEkey™ to retrieve the list of known users, meaning the users who
have at least one group in common with the current user;

2. SEkey™ selects the metadata (i.e. the name and the ID) of all the users from the encrypted
database stored in the SEcube™ device of the current user (noƟce that the database con-
tains exclusively users with at least one group in common);

3. SEkey™ fills a list containing all the details about the known users, then it returns an appro-
priate result code;

4. The user checks the return code and, if possible, uses the details of the known users for his
own purposes (i.e. displaying a list of ‘contacts‘ that are available for an encrypted commu-
nicaƟon).

8.7 SEkey™ APIs

The library of SEkey™ offers many APIs, however, inside the source code you will also find a lot of
other funcƟons that are used for internal purposes. The funcƟons listed in this secƟon are what
you need to build and exploit the KMS, do not use other funcƟons unless you are perfectly sure
that you have understood the documentaƟon and themeaning ofwhat is done in the source code.
Formore details about the implementaƟon of the SEkey™APIs, please refer to the Doxygen-based
documentaƟon.

int sekey_start(L0& l0, L1 *l1ptr);
int sekey_stop();

These APIs are used respecƟvely to start and stop SEkey™ . The first funcƟon takes as input pa-
rameters the pointers to the L0 and L1 object that are necessary to exploit the SEcube™ device.
NoƟce that those objects should be created by the higher levels, i.e. the ‘main‘ of your applica-
Ɵon. These funcƟonsmust be called when opening and closing the applicaƟon that needs to work
with SEkey™ .

int sekey_admin_init(L1& l1, vector<string>& pin, string&
userpin, string& adminpin);

This funcƟon is used to physically iniƟalize the SEcube™ device of the SEkey™ administrator.
Clearly, this funcƟon must be executed by the SEkey™ administrator only once, before starƟng
to build the KMS (i.e. adding users, groups and keys). NoƟce that this funcƟon can be executed
exclusively by the administrator of SEkey™ .
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int sekey_init_user_SEcube(string& uid, string& userpin, string&
adminpin, vector<string>& pin);

This funcƟon is used to physically iniƟalize a SEcube™ device dedicated to the user idenƟfied by
the ID specified as first parameter. The second and third parameter are the two PINs to be set on
the SEcube™ , in parƟcular, only the user PIN should be disclosed to the owner of the SEcube™
. The last parameter is a list of PINs to be used to login to the SEcube™ of the user before the
iniƟalizaƟon (the latest SEcube™ firmware uses a default PIN which is 32 bytes long, each byte is
equal to 0, so a list with a single PIN of all zeros should be enough).
NoƟce that the iniƟalizaƟon of the SEcube™ device of the user must be done aŌer calling the
sekey_add_user() funcƟon. However, you do not need to call this funcƟon immediately aŌer
the sekey_add_user(); you can delay it as long as you want, the only thing that maƩers is that
you call this funcƟon before physically giving the SEcube™ to the user.
NoƟce that this funcƟon can be executed exclusively by the administrator of SEkey™ .
For Linux users: when you connect the SEcube™ of the user to the host computer, remember to
mount the SEcube™ otherwise the iniƟalizaƟon might fail.

int sekey_add_user(string& user_id, string& username);

This funcƟon adds a new user to SEkey™ , using the required ID and username. If the ID is not
available, an error is returned. The user, when is added, does not belong to any group by default.
NoƟce that this funcƟon can be executed exclusively by the administrator of SEkey™ .

int sekey_delete_user(string& userID);

This funcƟon deletes the user specified by the ID passed as parameter from SEkey™ . The user will
be completely deleted from the system (i.e. from the list of users and from any group towhich the
user may belong); moreover, the SEcube™ of the deleted user will receive a special instrucƟon
that will result in the complete deleƟon of any informaƟon related to SEkey™ from the SEcube™of
the user (all the keys will be erased from the internal flash memory and the database containing
the metadata of the KMS will be empƟed). NoƟce that this funcƟon can be executed exclusively
by the administrator of SEkey™ .

int sekey_add_user_group(string& userID, string& groupID);

This funcƟon adds the given user to the given group. When the user is added, the other members
of the group are noƟfied of the presence of a new user (the administrator automaƟcally sends the
details of the new user to the other members of the group). Similarly, the new user is provided
with the details about all the other members of the group and with the encrypƟon keys associ-
ated to that group. NoƟce that this funcƟon can be executed exclusively by the administrator of
SEkey™ .

int sekey_delete_user_group(string& user_id, string& group_id);

This funcƟon deletes the given user from the given group; however, the user is sƟll part of SEkey™
. This means that all the keys of that group will be deleted from the SEcube™ of the user, more-
over, the user will loose contact with other users whose only common group was the one speci-
fied as parameter. NoƟce that this funcƟon can be executed only by the administrator of SEkey™ .

int sekey_user_change_name(string& userID, string& newname);
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This simple funcƟon allows to change the username of the user specified by the ID passed as pa-
rameter. This funcƟon can be executed exclusively by the administrator of SEkey™ .

int sekey_user_get_info(string& userid, se_user *user);
int sekey_user_get_info_all(vector<se_user> *users);
These funcƟons retrieve the details about a specific user (first one) or about all users (second
one), filling the object passed as second parameter. For more informaƟon about the aƩributes of
the object of class se_user, check the Doxygen documentaƟon. NoƟce that, when a user calls
this funcƟon, he cannot retrieve the details about any user of the system but only about the users
that he knows, meaning the user that have at least a common group with him.
NoƟce that these funcƟons can be used by the administrator and by the users.

int sekey_add_group(string& groupID, string& group_name,
group_policy policy);

This funcƟon adds a new group to SEkey™ , using the required ID, name, and security policy. If
the ID is not available, an error is returned. NoƟce that the new group, by default, is empty and
does not own any key. This funcƟon can be executed exclusively by the administrator of SEkey™ .

int sekey_delete_group(string& groupID);

This funcƟon deletes the given group from SEkey™ . The users belonging to the group will simply
be removed from the group and will not have access to its keys anymore. The keys associated to
the group will not be deleted, they will be deacƟvated and their owner will be set to ‘zombie‘ (i.e.
like with processes in an operaƟng system). The keys will sƟll be usable, by the administrator, to
decrypt old data; the administrator may also decide to delete all the keys of the group if they are
not needed anymore. NoƟce that this funcƟon can be executed exclusively by the administrator
of SEkey™ .

int sekey_group_change_name(string& groupID, string& newname);

Simply change the name of an exisƟng group. NoƟce that the other aƩributes of the group (i.e.
ID and involved users) are not changed. This funcƟon can be executed exclusively by the admin-
istrator of SEkey™ .

int sekey_group_change_max_keys(string& groupID, uint32_t
maxkeys);

Simply change the maximum number of encrypƟon keys that can be associated to an exisƟng
group. NoƟce that the other aƩributes of the group (i.e. ID and involved users) are not changed.
If the specified number of keys is lower than the current number of keys, the change does not
take place. This funcƟon can be executed exclusively by the administrator of SEkey™ .

int sekey_group_change_default_cryptoperiod(string& groupID,
uint32_t cryptoperiod);

Change the default cryptoperiod used for the encrypƟon keys of the specified group. NoƟce that
the change is applied only for keys that will be acƟvated aŌer this change, the encrypƟon keys
that were acƟvated in the past are not affected by this change therefore their expiraƟon date will
stay the same as before. This funcƟon can be executed exclusively by the administrator of SEkey™ .
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int sekey_group_get_info(string& groupID, se_group *group);
int sekey_group_get_info_all(vector<se_group> *groups);
These funcƟons retrieve the details about a specific group (first one) or about all groups (second
one), filling the object passed as second parameter. For more informaƟon about the aƩributes of
the object of class se_group, check the Doxygen documentaƟon. NoƟce that, when a user calls
this funcƟon, he cannot retrieve the details about any group of the system but only about the
groups to which he belongs. These funcƟons can be used by the administrator and by the users.

int sekey_add_key(string& key_id, string& key_name, string&
key_owner, uint32_t cryptoperiod, se_key_type keytype);

This funcƟon adds a new key to SEkey™ , using the required parameters. If the ID is not available,
an error is returned. NoƟce that the caller must provide also the owner of the key, meaning the
ID of the group that is associated to the key (i.e. the key ‘K11‘ is associated to the group ‘G7‘).
The cryptoperiod is opƟonal, the caller can insert ‘0‘ to use the default cryptoperiod of the group
owner of the key. Finally, noƟce that the key type must be always ‘symmetric_data_encrypƟon‘.
This funcƟon can be executed exclusively by the administrator of SEkey™ .

int sekey_activate_key(string& key_id);

This funcƟon is used to acƟvate the key specified by the ID passed as parameter. Upon acƟvaƟon,
the expiraƟon Ɵme is set depending on the cryptoperiod of the key. NoƟce that a key can be
acƟvated only if its status is ‘pre-acƟve‘ or ‘suspended‘ (in this last case it is a re-acƟvaƟon). Once
a key is acƟvated, it can be used to encrypt data. This funcƟon can be executed exclusively by the
administrator of SEkey™ .

int sekey_key_change_status(string& key_id, se_key_status status
);

This API is used to change the status of an encrypƟon key, according to Figure 30. NoƟce that to
change the status to ‘acƟve‘, there is a dedicated funcƟon. The status of a key must be changed
by the administrator according to the condiƟons of the environment, for example if the admin-
istrator suspects that a key has been found by an unauthorized enƟty, then the key must be set
to the ‘compromised‘ state. Similarly, to destroy a key its status can simply be set to ‘destroyed‘
and it will be erased from all SEcube™ devices that have it in their flash memory. NoƟce that this
funcƟon can be executed exclusively by the administrator of SEkey™ .

int sekey_key_change_name(string& key_id, string& key_name);

This funcƟon is simply used to change the label of an encrypƟon key. The other aƩributes of the
key remain unchanged. NoƟce that this funcƟon can be executed exclusively by the administrator
of SEkey™ .

int sekey_key_get_info(string& key_id, se_key *key);
int sekey_key_get_info_all(vector<se_key> *keys);
These funcƟons retrieve the details about a specific key (first one) or about all keys (second one),
filling the object passed as second parameter. For more informaƟon about the aƩributes of the
object of class se_key, check the Doxygen documentaƟon. NoƟce that, when a user calls this
funcƟon, he cannot retrieve the details about any key of the system but only about the keys that
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are stored on his personal SEcube™ , meaning the keys associated to the groups to which he be-
longs. NoƟce that these funcƟons can be used by the administrator and by the users.

int sekey_find_key_v1(string& chosen_key, string& source_user_id
, string& dest_user_id, se_key_type keytype);

int sekey_find_key_v2(string& chosen_key, string& source_user_id
, string& group_id, se_key_type keytype);

int sekey_find_key_v3(string& chosen_key, string& source_user_id
, vector<string>& dest_user_id, se_key_type keytype);

These APIs allow to find the most secure key to be used in different scenarios:

• the first funcƟon is used in a 1-to-1 communicaƟon (i.e. ‘U1‘ wants to send an encrypted
message to ‘U2‘) , therefore both parƟes must share at least one common group;

• the second funcƟon is used in a 1-to-N communicaƟon, where the sender is a single user
and the recipients are all the members of a specific group;

• the third funcƟon is used in a 1-to-N communicaƟon, where the sender is a single user and
the recipients are a set of users. NoƟce that, if all the users involved (sender and recipients)
do not share at least one common group, this funcƟon will fail because it will be impossible
to find a single key that can be used for all recipients.

The ‘keytype‘ parameter must be ‘symmetric_data_encrypƟon‘ (it was added explicitly to make
the KMS able to handle also other types of keys in the future). NoƟce that in the first and in the
third funcƟon, the most important rule to find the most secure key is to find an acƟve key (i.e. us-
able for encrypƟon) belonging to the smallest group containing all the users involved. This does
not automaƟcally imply that only the involved users have access to that key, for example two
users may have only a group in common, which includes 3 other users; therefore also these users
will have access to the chosen key and will be able to decrypt the data. CreaƟng small groups of
2 users to enable secure 1-to-1 communicaƟon is considered to be a responsibility of the admin-
istrator. NoƟce that these funcƟons can be used only by the users of SEkey™ .

int sekey_readlog(string* sn, string& output);

This funcƟon opens the log file generated by the SEcube™ device with the serial number passed
as first parameter and copies its content, as cleartext, into the string passed as second parameter;
the string then can be printed to a normal text file for further analysis. NoƟce that the log file is
generated automaƟcally by the administrator and by each user of SEkey™ , the log file is useful
to record which acƟons have been performed in a specific moment. NoƟce that this funcƟon can
be executed exclusively by the administrator of SEkey™ .

int sekey_recovery_request(string& user_id, string&
serial_number);

This funcƟon can be used to recover the integrity of the data of SEkey™ concerning a specific
user. Let us imagine that a user has deleted the encrypted file used by SEkey™ from the MicroSD
of his SEcube™ or, for some reason, SEkey™ is not working properly on the SEcube™ of the user.
The administrator can try to solve the problem calling this funcƟon that, given the ID of the user
and the serial number of his SEcube™ , sends again to the user all the data that he is allowed
to access (keys, groups, users, etc.). NoƟce that this funcƟon can be executed exclusively by the
administrator of SEkey™ .
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int sekey_check_expired_keys();

This is a simple funcƟon that iterates over all the keys stored within SEkey™ , checking if the expi-
raƟon Ɵme of the key has been reached or not. If it has been reached and the key has not been
deacƟvated yet, then it deacƟvates the key. NoƟce that this funcƟon has no effect if the key is al-
ready in the status ‘deacƟvated‘, ‘compromised‘, or ‘destroyed‘. This funcƟon is used extensively
within the APIs of SEkey™ and SEfile™ to ensure that expired keys are never used when they are
not supposed to be used. However, this funcƟon can be safely called also by higher levels from
Ɵme to Ɵme (but it is not strictly necessary); noƟce that it can be called by the administrator and
the users.

int sekey_update_userdata();

This funcƟon is called automaƟcally by SEkey™ , but the higher levels may safely call it from Ɵme
to Ɵme (but it is not strictly necessary). Its purpose is to check if the administrator has sent any
new data related to SEkey™ , concerning the current user. This funcƟon can be called exclusively
by the users of SEkey™ , it cannot be called by the administrator.
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9 Geƫng Started

9.1 The SEcube™ System Setup

In this SecƟon, we outline the set of both hardware and soŌware resources you need to set up
the SEcube™ DevKit.
At the end of this SecƟon, you will have acquired a clear overview of the prerequisites to set up
the environment.

9.1.1 Hardware resources

The following hardware resources are needed (detailed in the following paragraphs):

1. A PC

2. The SEcube™ Open SDK

3. The SEcube™ DevKit

You do not need a parƟcularly new or powerful PC to get started with the SEcube™ DevKit. Mini-
mal requirements include:

• 2+ GiB33 of RAM

• 10+ GiB of empty/available space on HDD

• USB ports

To program the STM32F429 processor available on the SEcube™ DevKit you can follow two alter-
naƟves, resorƟng to:

• an in-circuit programmer and debugger, and parƟcularly to the ST-Link/v234,

• one board such as the STM Discovery or STM Nucleo, equipped with a ST-Link/v2 program-
mer, respecƟvely.

The ST-LINK/V2 is an in-circuit debugger and programmer for the STM8 and STM32 microcon-
troller families. Its JTAG/serial wire debugging-programming (SWD) interface is used to commu-
nicate with the STM32 microcontroller comprised within the SEcube™ DevKit. This programmer
requires 5V power supplied by a standard USB connector (A to Mini-B cable) compaƟble with the
USB 2.0 interface. We suggest geƫng the programmer through RS35, at a price of 19.19 €. Your
purchase should comprise the following items (Figure 33):

• The St-Link/v2 programmer

• USB 2.0 A to Mini-B cable

• JTAG to SWD cable

• SWIM cable (not needed to program the SEcube™ DevKit)

33For the purpose of this document 1 GiB = 230 Bytes
34http://www.st.com/en/development-tools/st-link-v2.html
35http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/7141701/?sra=pmpn

http://www.st.com/en/development-tools/st-link-v2.html
http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/7141701/?sra=pmpn
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Figure 33: Components purchased with the ST-Link/v2 programmer

The ST Discovery and ST Nucleo boards represent an affordable and flexible way for users to build
project with a microcontroller from the STM32 family, choosing from the various combinaƟons
of performance, power consumpƟon and features.
These boards do not require any separate probe as they both integrate a ST-Link/V2 program-
mer/debugger.
The STM32 Nucleo board comes with the STM32 comprehensive soŌware HAL library together
with various packaged soŌware examples, as well as direct access to online resources. We sug-
gest geƫng the boards through RS. It is important to clarify that you do not need to buy them
both: you can buy only one board, and your purchase will in any case represent a valid alternaƟve
to the ST-Link/v2 programmer.
The recommended Discovery36 and Nucleo37 boards can both be bought through RS. In both
cases, you should get the board with a USB 2.0 A to Mini-B cable.
The SEcube™ DevKit can be ordered online38.
Your purchase should comprise the following items, depicted in Figure 34:

• The SEcube™ DevKit;

• A USB 2.0 A to Micro-B cable

36http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/9107951/
37http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/8029425/
38http://www.secube.eu

http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/9107951/
http://it.rs-online.com/web/p/kit-di-sviluppo-per-processori-e-microcontrollori/8029425/
http://www.secube.eu
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Figure 34: Components purchased with the SEcube™ DevKit

In order to make the DevKit work properly, you should also purchase a MicroSD card with a min-
imum capacity of 4 GiB. The card must then be inserted in the dedicate socket (J4002).

9.1.2 SoŌware resources

You need the following tools:

1. OperaƟng System

2. Java RunƟme Environment

3. Eclipse

4. AC6 Tools: GNU ARM Embedded Toolchain

5. STM32CubeMX - STM32Cube iniƟalizaƟon code generator

6. Laƫce Diamond SoŌware

7. ST-Link/v2 drivers

8. ST-Link UƟlity

9. Open Source SDK

Two OperaƟng Systems are currently supported:

• Windows 7 (or later)39

• Linux with Kernel 2.6 (or later)40

39This procedure has been tested with Windows 7 Professional x64
40This procedure has been tested with both Linux Chakra kernel 4.5.7-1 x64 and Linux Ubuntu 14.04LTS x64
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The Java RunƟme Environment (JRE) is a soŌware package that contains what is required to run
a Java program. It includes a Java Virtual Machine implementaƟon together with an implementa-
Ɵon of the Java Class Library. TheOracle CorporaƟon, which owns the Java trade-mark, distributes
a Java RunƟme environment with their Java Virtual Machine called HotSpot.
Version Required
Version 8u111 (or later)
How to get it
The program is available free of charge from the Oracle website41.
InstallaƟon hints
Visit the download link and follow the instrucƟons as in the following screenshot:

What is going to be used for
The Java RunƟme Environment is required for Eclipse to work properly.

Eclipse is of the most widely used free and open-source integrated development environment
(IDE) in computer programming.
It contains a base workspace and an extensible plug-in system for customizing the environment.
Eclipse is wriƩen mostly in Java and its primary use is for developing Java applicaƟons, but it may
be used to develop applicaƟons in other programming languages as well, resorƟng to dedicated
plugins.
Version required
Version 4.6 Neon (or later)
How to get it
You need to download the Eclipse IDE for C/C++ Developers42.
InstallaƟon hints
Visit the download link and follow the indicaƟons of the website to download the correct version.
Pay aƩenƟon to choose the same architecture (32-bit or 64-bit) for both Eclipse and the Java
Virtual Machine in your PC. You can verify which version of Java is present in your machine by
launching the command “java -version” in a Command Prompt: its outcome would clearly state
if the Java version within your PC is a 64-bit architecture (otherwise you should assume that it is
a 32-bit architecture).
If the two architectures do not match, it is possible that Eclipse will show this error on startup:
“Can’t start Eclipse - Java was started but returned exit code=13”.
41http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
42https://www.eclipse.org/downloads/

http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
https://www.eclipse.org/downloads/
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What it’s going to be used for
Eclipse is the recommended IDE to develop applicaƟons that will run on the STM32F429 proces-
sor of the SEcube™ DevKit.

The AC6 Tool will install the GNU Embedded Toolchain for ARM, which is a ready-to-use, open
source suite of tools for C, C++ and Assembly programming targeƟng ARM Cortex-M and Cortex-R
family of processors. It includes the GNU Compiler (GCC) and is available free of charge directly
from ARM for embedded soŌware development on both Windows and Linux operaƟng systems.
The referenceplaƞorm for this document is the SystemWorkbench for STM32 (SW4STM32) Eclipse
plugin.
SW4STM32 is an integrated environment that includes:

• Building tools (GCC-based ARM cross compiler, assembler and linker);

• OpenOCD and GDB debugging tools;

• Flash programming tools

Version required
Version 5.0 (or later).
How to get it
To install SW4STM32 as an Eclipse plugin:

1. launch Eclipse IDE

2. on the toolbar, click «Help » Install New SoŌware…»

3. in the Available SoŌware window, click «Add»
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4. in the Add Repository window, set Name and LocaƟon fields as follows, and then click «OK»
• Name: SystemWorkbench for STM32 - Bare Machine ediƟon
• LocaƟon: hƩp://www.ac6-tools.com/Eclipse-updates/org.openstm32.system-workbench.site

5. select OpenSTM32 Tools and click «Next»

6. accept the license agreement and click «Finish» to start the plugin installaƟon, conƟnue the
installaƟon also if a warning for incompaƟble or unsigned components is prompted

7. restart Eclipse

What it’s going to be used for
The toolchain will be used to create, build, debug and in general to manage project that will be
executed from the STM32 microcontroller comprised within the SEcube™ DevKit.

STM32CubeMX is a graphical soŌware configuraƟon tool that allows generaƟng C iniƟalizaƟon
code using graphical wizards. It also embeds a comprehensive soŌware plaƞorm, delivered per
series. This plaƞorm includes the STM32Cube HAL (an STM32 abstracƟon layer embedded soŌ-
ware, ensuringmaximized portability across STM32 porƞolio), plus a consistent set ofmiddleware
components (RTOS, USB, TCP/IP and graphics). All embedded soŌware uƟliƟes come with a full
set of examples.
STM32CubeMX is an extension of the exisƟng MicroXplorer tool. It is a graphical tool that allows
configuring STM32 microcontrollers very easily and generaƟng the corresponding iniƟalizaƟon C
code through a step-by-step process.
The reference plaƞorm for this document is the STM32CubeMX Eclipse plugin.
Version required
Version 4.0 (or later)
How to get it
The soŌware is downloadable free of charge online43.
AŌer having registered to the website, it will be possible to download a .zip file containing the
STM32CubeMX Eclipse plugin; to install it then follow these steps:

1. launch Eclipse IDE

2. on the toolbar, click «Help » Install New SoŌware…»

3. in the Available SoŌware window, click «Add»

4. in the Add Repository window click on «Archive», select the downloaded ZIP file, and click
«OK»

5. check the box corresponding to STM32CubeMX plugin and click «Next»

6. accept the license agreement to install the plugin, conƟnue the installaƟon also if a warning
for incompaƟble or unsigned components is prompted

7. restart Eclipse

43http://www.st.com/en/development-tools/stsw-stm32095.html. As an alternaƟve (not recommended), it is pos-
sible to install the soŌware as a standalone by downloading and extracƟng the .zip file downloadable from
hƩp://www.st.com/en/development-tools/stm32cubemx.html. If you work under Windows, you can execute di-
rectly the .exe executable; if youwork under Linux, you have the launch the following command from the command
prompt “sudo java -jar filename.exe” (subsƟtuƟng “filename” with the actual file-name of the executable) and to
insert your user password if required.

http://www.st.com/en/development-tools/stsw-stm32095.html.
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What it’s going to be used for
STM32CubeMX eases system development providing:

• C code generaƟon covering iniƟalizaƟon code for standard toolchains

• Embedded soŌware libraries andmiddleware components (e.g., Open-source TCP/IP stack,
USB drivers, open-source FAT file system, open source RTOS) with related examples

Laƫce Diamond® soŌware is the leading-edge soŌware design environment for cost-sensiƟve,
low-power Laƫce FPGA architectures. Laƫce Diamond’s integrated tool environment provides
a modern, comprehensive user interface for controlling the Laƫce Semiconductor FPGA imple-
mentaƟon process.
Version required
Version 3.5 (or later)
How to get it
The soŌware is downloadable free of charge online44.
InstallaƟon hints
When downloading the soŌware, it is possible to choose the free license.
What it’s going to be used for
The soŌware will be used for controlling the implementaƟon process of the Laƫce Semiconduc-
tor FPGA comprised within the SEcube™ DevKit.

ST-Link v2 drivers provide support for the ST-Link/v2 programmer.
Version required
Version 4.0.0 (or later)
How to get it
The soŌware is downloadable free of charge online45.
InstallaƟon hints
During the installaƟon procedure, it is possible to receive warnings from the OperaƟng System if
drivers are not properly signed; however, the installaƟon procedure should not be interrupted.
What it’s going to be used for
To allow the usage of the ST-Link/v2 programmer.

The STM32 ST-LINK UƟlity soŌware facilitates fast in-system programming of the STM32 micro-
controller families in development environments via the ST-LINK and ST-LINK/V2 tools.
Version required
Version 4.0.0 (or later)
How to get it
The soŌware is downloadable free of charge online for Windows users46.
Linux user, instead, can resort to the Open On-Chip Debugger (OpenOCD); this soŌware is down-
loadable free of charge online47.
What it’s going to be used for
To speed up the usage of the ST-Link/v2 programmer.

A SoŌware Development Kit (SDK or ”devkit”) is typically a set of soŌware development tools
that allows the creaƟon of applicaƟons for a given system. To exploit all the funcƟonaliƟes of

44http://www.latticesemi.com/Products/DesignSoftwareAndIP/FPGAandLDS/LatticeDiamond
45http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/

stsw-link009.html
46http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/

stsw-link004.html
47https://sourceforge.net/projects/openocd/files/openocd/0.9.0/

http://www.latticesemi.com/Products/DesignSoftwareAndIP/FPGAandLDS/LatticeDiamond
http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/stsw-link009.html
http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/stsw-link009.html
http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/stsw-link004.html
http://www.st.com/content/st_com/en/products/embedded-software/development-tool-software/stsw-link004.html
https://sourceforge.net/projects/openocd/files/openocd/0.9.0/
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your SEcube™ DevKit, we provide a free and open-source SDK which are commented in this doc-
ument.
Of relevance within this SDK is a configuraƟon file (“SEcubeDevBoard.ioc”) which stores the con-
figuraƟon of microprocessor integrated in the SEcube™ DevKit.
How to get it
This file is available as part of the Open Source SDK which can be downloaded from the follow-
ing link: https://www.secube.eu/resources/open-sources-sdk/. Once downloaded, extract the
content into a known locaƟon, and keep extracƟng subarchives unƟl you are able to browse to “SE-
CubeSDK/SDKdevice side/code/opƟmized_apis_firmware_nonblockinglogin/secube_sdk/development”
to find “SEcubeDevBoard.ioc”.
What it’s going to be used for
The configuraƟon file is used to generate automaƟcally soŌware driver and or custom configura-
Ɵons tailored for the microprocessor integrated in the SEcube™ DevKit.

9.1.3 Assembling the System

In this SecƟon, we list the instrucƟons you need to follow to properly connect the SEcube™DevKit
to the Host PC and to Programmer/debugger, as shown in Figure 35.
At the end of this SecƟon you will have acquired a clear overview of the procedures to follow to
start using the environment.

Figure 35: System Architecture

9.1.4 Assembling Steps

If you decide to use the ST-Link/v2 programmer, assembling is composed of the following two
steps:

1. Connect the SEcube™ DevKit with the programmer by means of the JTAG/SWD cable: the
cable should be inserted on the JTAG docks on both the programmer (in this case the ori-
entaƟon of the plug is forced from the dock) and the DevKit (in this case you must pay
aƩenƟon in inserƟng the plug on top of both lines of connectors and with its protrusion
oriented towards the inner side of the DevKit)

2. Connect the ST-Link/v2 with the PC by means of the USB cable

https://www.secube.eu/resources/open-sources-sdk/
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The system assembled is shown in Figure 36, while a close-up on the JTAG connecƟon is in Figure
37.

Figure 36: ConnecƟon between the STLink/v2 programmer and the SEcube™ DevKit

Figure 37: ConnecƟon between the STLink/v2 programmer and the SEcube™ DevKit, close-up
(highlighted in red) on the JTAG connector orientaƟon

If you decide to use the ST-Link programmer comprised within a Discovery or Nucleo board, as-
sembling requires the following three steps:

1. Isolate the programmer from the rest of the board bymoving the jumpers to reach the con-
figuraƟon shown in Figure 39 and described in the STM32 Nucleo-64 boards user manual48

48Available at the following link, please refer to SecƟon 6.2.4 of the User Manual of the STM32 Nucleo board: https://

https://www.st.com/content/ccc/resource/technical/document/user_manual/98/2e/fa/4b/e0/82/43/b7/DM00105823.pdf/files/DM00105823.pdf/jcr:content/translations/en.DM00105823.pdf#page=18&zoom=100,0,652
https://www.st.com/content/ccc/resource/technical/document/user_manual/98/2e/fa/4b/e0/82/43/b7/DM00105823.pdf/files/DM00105823.pdf/jcr:content/translations/en.DM00105823.pdf#page=18&zoom=100,0,652
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2. Connect the SEcube™ DevKit with the programmer by means of the JTAG/SWD cable: the
cable should be inserted on the JTAGdocks of theDevKit (youmust pay aƩenƟon in inserƟng
the plug with its protrusion oriented towards the inner side of the DevKit) and on the SWD
dock of the board, accordingly to the schema in Figure 38

3. Connect the ST-Link/v2 with the PC by means of the USB cable.

Figure 38: Programmer SWD pins schema

www.st.com/content/ccc/resource/technical/document/user_manual/98/2e/fa/4b/e0/82/43/b7/DM00105823.
pdf/files/DM00105823.pdf/jcr:content/translations/en.DM00105823.pdf#page=18&zoom=100,0,652

https://www.st.com/content/ccc/resource/technical/document/user_manual/98/2e/fa/4b/e0/82/43/b7/DM00105823.pdf/files/DM00105823.pdf/jcr:content/translations/en.DM00105823.pdf#page=18&zoom=100,0,652


The SEcube™ Open Security Plaƞorm
Document ClassificaƟon: Public

Page 95 of 130
Release: 010

Figure 39: Jumpers configuraƟon to isolate the ST-Link programmer on a Discovery board (high-
lighted in red, the same applies to Nucleo boards)

Figure 40: ConnecƟon between the Discovery board and the DevKit (the same applies to Nucleo
boards)

9.1.5 What it should happen

AŌer having properly connected the programmer through the USB interface its signaling LED
should turn on; aŌer having properly connected the DevKit through the USB interface all its LEDs



The SEcube™ Open Security Plaƞorm
Document ClassificaƟon: Public

Page 96 of 130
Release: 010

should turn on.

9.2 Installing the SEcube™ OpenSource SoŌware Libraries

In this SecƟon, we list the instrucƟons you need to follow to import the SEcube™ soŌware libraries
within an Eclipse project.
At the end of this SecƟon you will have acquired a clear overview of the procedures to follow to
import the libraries and use them to foster the development of your applicaƟon.

9.2.1 SEcube™ Open Source SoŌware Libraries - Device Side

Hereby is listed a step-by-step guide to create the binaries files that will be executed on the
SEcube™ DevKit:

1. Download the SDKpackage containing the project fromhttps://www.secube.eu/resources/
open-sources-sdk/

2. Extract the .zip file to a known locaƟon

3. Open the folder ”SEcube SDK_v1.4_1” andextract the content of the archive ”SECubeSDK.tar.gz”

4. From your locaƟon, go to ”SECubeSDK/SDK device side/code” and extract the content of
the archive ”opƟmized_apis_firmware_nonblockinglogin.zip”

5. Open the folder ”opƟmized_apis_firmware_nonblockinglogin” and extract the content of
the archive ”secube_sdk.zip”

6. Fromyour locaƟon, go to ”secube_sdk/development” and extract the content of the archive
”environment.zip”

7. Launch Eclipse

8. Change Eclipse perspecƟve to «C/C++ selecƟng Window » PerspecƟve » Open PerspecƟve
» Other… » C/C++»

9. Switch the Eclipse workspace to «File » Switch Workspace » Other…» and select the “ws”
folder contained within the “environment” folder previously extracted from the .zip file

https://www.secube.eu/resources/open-sources-sdk/
https://www.secube.eu/resources/open-sources-sdk/
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10. Set the Debug configuraƟon from «Project » Build ConfiguraƟon » Set AcƟve»

11. Build the project in Debug mode from «Project » Build All»

12. Set the Release configuraƟon from «Project » Build ConfiguraƟon » Set AcƟve»

13. Build the project in Release mode from «Project » Build All»

14. Right-click on the project in the Project Explorer and select «Refresh»
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15. Connect the DevKit as described in previous secƟon

16. Run the project by right-clicking on it in the Project Explorer and selecƟng the Release binary
under «Target » Program Chip» (i.e., select the label containing the string “/Release”)

17. Wait unƟl the debugger shows the messages “Programming Finished” and “Verified OK”
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Now your DevKit is fully configured and the STM32microprocessor is ready to be used to develop
your security applicaƟons.

9.2.2 SEcube™ Open Source SoŌware Libraries – Host Side

Hereby is listed a step-by-step guide to create a C project to use leverage on the capabiliƟes of
the DevKit:

1. Repeat the steps indicated in 9.2.1 up to point 5

2. Launch Eclipse

3. Change Eclipse perspecƟve to «C/C++ selecƟng Window » PerspecƟve » Open PerspecƟve
» Other… » C/C++»

4. Import the project «File » Import…», select “ExisƟng file into workspace” and press “Next”,
Select archive file named ”secube_host_emptyproject.zip”, browse to the file downloaded
and press “Finish”
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5. Set your preferred configuraƟon from «Project » Build ConfiguraƟon » Set AcƟve»

6. Build the project from «Project » Build All»

7. Connect the SEcube™ DevKit with the USB cable

8. Now you are ready to write your code within the “main.c” file in the Project Explorer, com-
pile it and run it

9.3 Running your first programs

This SecƟon guides you to set-up, edit, and use the basic examples and tutorials provided as simple
entry points to the environment, leveraging on the capabiliƟes provided by the microcontroller.

9.3.1 Hello World (host-side)

Typically, the first program you run in a new environment is a basic one (e.g., one prinƟng a string
such as “HelloWorld” on the screen) intended to let you test that the environment is properly con-
figured and to familiarize with the configuraƟons needed to make the program code executable.
The code shown in Appendix C is a first example of how to use the Open Source Libraries; it resorts
only on the STM32 microprocessor as it tries to log in and out from your SEcube™ DevKit.
Hereby we list a step-by-step guide to run your first program on the SEcube™ DevKit.
Note: to run this soŌware you must have already iniƟalized your device.
To use it follow this step-by-step guide:

1. Launch Eclipse

2. Import the project following secƟon 9.2.2

3. Open the file named “main.c”

4. Replace its content with the code shown in Appendix C (it can also be found in the SDK
under the folder “SEcube_SDK/Libraries/Examples/HelloWorld/”)
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5. Connect the DevKit with USB cable

6. Set the Release configuraƟon from «Project » Build ConfiguraƟon » Set AcƟve»

7. Build the project from «Project » Build All»

8. Run the project

When seƫng up a project with the provided files for the API, a directory structure is implicitly
assumed. As SEfile includes “se3/L0.h”, “se3/L1.h” etc., a folder “se3” must be present to contain
the expected parts of the API. The tool for seƫng up the environment could serve as such an
example project49.

9.3.2 FPGA_LED (device-side)

The procedure shown in this paragraph guides you to a first example of how to use the Open
Source Libraries with the FPGA; it programs the FPGA embedded in the SEcube™ chip to make
the led blink.
Hereby we list a step-by-step guide to run this program:

1. Import the project as described in secƟon 9.2.1

2. Import the necessary «File » Import…», select “Filesystem” and press “Next”

3. Browse to the directory where the SDK has been downloaded and then to the path “SE-
cube_SDK/Libraries/Examples/TestFPGA/”

4. Select the files in that folder (FPGA.c, FPGA.h and TEST_FPGA.h); youmight want to set also
“DesƟnaƟon Folder” to “SEcubeDevBoard/ApplicaƟon/src” and then press “Finish”

49Freely available on-line (https://bitbucket.org/ede1/secube-command-line-tools.git)

https://bitbucket.org/ede1/secube-command-line-tools.git
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5. Configure both “Debug” and “Release” configuraƟons from «Project » ProperƟes » C/C++
Build » MCU GCC Compiler » Includes» and add the “DesƟnaƟon folder”

6. Now edit the code in “main.c” file including the header file “FPGA.h”

7. Also in “main.c” add a call to B5_FPGA_Programming() funcƟon

8. Open the file named “gpio.c” and add the following lines to the funcƟon MX_GPIO_Init
(), needed for configuring the JTAG port used for programming the FPGA:

/*Configure GPIO pin : PE2 */
GPIO_InitStruct.Pin = GPIO_PIN_2;
GPIO_InitStruct.Mode = GPIO_MODE_INPUT;
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GPIO_InitStruct.Pull = GPIO_NOPULL;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);
/*Configure GPIO pins : PE3 PE4 PE5 PE6 */
GPIO_InitStruct.Pin = GPIO_PIN_3|GPIO_PIN_4|GPIO_PIN_5|

GPIO_PIN_6;
GPIO_InitStruct.Mode = GPIO_MODE_OUTPUT_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
GPIO_InitStruct.Speed = GPIO_SPEED_HIGH;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);

9. Save the changes to all files and build the project

10. Connect the DevKit as described in previous secƟon

11. Run the project by right-clicking on it in the Project Explorer and selecƟng the Release binary
under «Target » Program Chip» (i.e., select the label containing the string “/Release”)

NoƟce that the aŌer turned on, programming of the FPGAmight require some Ɵme (1-2 minutes)
to be completed. AŌer that, you should see that the led on the board start blinking.

9.3.3 A FuncƟonal Test

In this SecƟon, we list the instrucƟons to follow to run the FuncƟonal Test provided with the
SEcube™ DevKit.
At the end of this SecƟon you will have acquired a clear overview of the procedures to follow to
run programs on the environment.
NoƟce that to run this program your SEcube™ DevKit must be already iniƟalized.
In the sequel you can find a step-by-step guide to run the provided funcƟonal test:

1. Import the project following secƟon 9.2.2

2. Locate the project in the folder “secube_sdk/Examples/FuncƟonalTest”

3. Locate the “funct_test.c” file in the Project Explorer

4. Right-click on it and select “Delete”

5. Import the new “main.c” file from «File » Import…», select “File System” and press “Next”,
browse the file “secube_sdkK/Examples/FuncƟonalTest” folder within the folder previously
extracted, select the “funct_test.c” file and press “Finish”

6. Set the Debug configuraƟon from «Project » Build ConfiguraƟon » Set AcƟve»

7. Build the project in Debug mode from «Project » Build All»

8. Set the Release configuraƟon from «Project » Build ConfiguraƟon » Set AcƟve»

9. Build the project in Release mode from «Project » Build All»

10. Right-click on the project in the Project Explorer and select «Refresh»

11. Connect the SEcube™ DevKit with USB cable

12. Run the project by right-clicking on it in the Project Explorer and selecƟng the Release binary
under «Run as » Local C/C++ ApplicaƟon»
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The provided funcƟonal test exploits capabiliƟes offered by the Open Source SDK to show the
basic common operaƟons typically used with a SEcube™ device; to provide an in-depth under-
standing of it, its code is hereby decomposed and commented.
The funcƟonal test can be found in the SDK in under the folder
“secube_sdk/Libraries/Examples/FuncƟonalTest/”. StarƟng from the includes instrucƟons

#include <stdint.h>
#include <stdbool.h>
#include "../secube−host/L1.h"

it is possible to see how the SDK level “L1”, offering high-level funcƟons, is being used. The global
declaraƟons

static uint8_t pin[32] = {
'a','b','c','d', 0,0,0,0, 0,0,0,0, 0,0,0,0,
0,0,0,0, 0,0,0,0, 0,0,0,0, 0,0,0,0

};
static uint8_t pin0[32] = {

0,0,0,0, 0,0,0,0, 0,0,0,0, 0,0,0,0,
0,0,0,0, 0,0,0,0, 0,0,0,0, 0,0,0,0

};

contain the PIN used to access the device. Each PIN is a generic value of 32-byte. Note that the
value of pin0 is used to login the first Ɵme just aŌer the device is iniƟalized.
Skipping to the main, there is a common snippet used to list all the SEcube™ device connected to
the host:

L0_discover_init(&it);
while (L0_discover_next(&it)) {

printf("SEcube found!\nInfo:\n");
printf("Path:\t%ls\n", it.device_info.path);
printf("Serial Number: ");
print_sn(it.device_info.serialno);
printf("\n\n");

}

Here it is shown how you can retrieve informaƟon about the device (i.e., its path and its serial
number) from the structure it.device_info.
Next step allows to open the device (if it is correctly found).

L0_discover_init(&it);
if (!L0_discover_next(&it)) {

return_value = L0_open(&dev, &(it.device_info), SE3_TIMEOUT);
}
if (return_value != SE3_OK) {

printf("Error opening device\nAbort Tests");
return(0);

}
else {

printf("Open Device success\n");
}

Without knowing which SEcube™ device is of interest, here the first available device is opened
with L0_open() funcƟon from level “L0”. It should be noted that every funcƟon in the SDK
returns a value staƟng whether the operaƟons has been completed successfully (SE3_OK) or not
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(in this case the value returned is bigger than 1). So, it is good pracƟce to always check for the
expected return value aŌer calling a funcƟon of the SDK.
When a device is opened, it does not offer any faciliƟes but the echo service. This service can be
used to test if the link between the host and the device side is working and the peripherals can
communicate.

if (test_echo(&dev)) {
printf("Echo success\n");

}
else {

printf("Error Echo\n");
}

The funcƟon test_echo() does not belong directly to the SDK; it requires as only parameter a
pointer to the device where to test the echo service. In this funcƟon, the buffer of random data
to be sent is generated and the one to be received is allocated. The test will send by default 1MiB
of data.

enum {
TEST_SIZE = 1 * 1024 * 1024

};
...
test_randbuf(TEST_SIZE, &sendbuf);
recvbuf = (uint8_t*)malloc(TEST_SIZE);
The test is repeated for NRUN Ɵmes. The data sent can be at most SE3_REQ_MAX_DATA bytes.

for (rep = 0; rep < NRUN; rep++) {
printf("Echo − Run %d... ", rep);
sp = sendbuf;
rp = recvbuf;
n = TEST_SIZE / SE3_REQ_MAX_DATA;
for (i = 0; i < n; i++) {

r = L0_echo(dev, sp, SE3_REQ_MAX_DATA, rp);
if (SE3_OK != r) goto cleanup;
sp += SE3_REQ_MAX_DATA;
rp += SE3_REQ_MAX_DATA;

}
}

Finally, the data received in recvbuff is compared with the one sent sendbuf:

if (memcmp(sendbuf, recvbuf, TEST_SIZE)) goto cleanup;
printf(" −> OK\n");

To use any service offered by the SEcube™device other than the echo service, the login procedure
is required. The funcƟontest_login() showshow toperform log in operaƟonswith the device.
Several login operaƟons are completed with different PINs:

• Log in as User with default pin (all zeroes) - It should fail when iniƟalized

return_value = L1_login(&s, dev, init_pin, SE3_ACCESS_USER
);

• Log in as User with correct PIN

return_value = L1_login(&s, dev, pin, SE3_ACCESS_USER);
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• Log in as Admin with correct PIN

return_value = L1_login(&s, dev, pin, SE3_ACCESS_ADMIN);

• Log in as User with wrong PIN

return_value = L1_login(&s, dev, pin_aaaa, SE3_ACCESS_USER
);

To pass this test, both User and Admin PIN must be set to “test” (otherwise you should change
accordingly the content of the pin arrays).
The last operaƟon in the funcƟon test_algorithm() shows how to get the list of encrypƟon
algorithms available. Also for accessing to this service, the login is required.
First a suitable array is created:

#define MAX_ALG 10
...
se3_algo alg_array[MAX_ALG];

Then, the “L1” funcƟon requesƟng the algorithm list is called

printf("Retrieving algorithm list...\n");
return_value = L1_get_algorithms(&s, 0, MAX_ALG, alg_array, &

count);
if (return_value != SE3_OK) {

printf("Error retrieving algorithm list");
return(!SE3_OK);

}

Finally, for each algorithm received (i.e., available on the device), its characterizing informaƟon
(e.g., its name) are printed out with the following code:

for (i = 0; i < count; i++) {
memcpy(buff_name, alg_array[i].name,

SE3_CMD1_CRYPTO_ALGOINFO_NAME_SIZE);
printf("Algorithm name: %s\n", buff_name);
printf("Algorithm type: %u\n", (unsigned int)alg_array[i].type

);
printf("Algorithm block size: %u\n",(unsigned int)alg_array[i

].block_size);
printf("Algorithm key size: %u\n\n\n", (unsigned int)alg_array

[i].key_size);
}

9.4 From the SEcube™ DevKit to the USEcube™ SƟck

To migrate your project from the SEcube™ DevKit to the USEcube™ SƟck, you do not need any
programmer. You have just to use the boot loader embedded in the USEcube™ SƟck and the
SEcube™ USB Loader Free SoŌware available online50.
This soŌware allows injecƟng your binary image file into the internal SEcube™ flash, starƟng from
the address 0x08020040. Once you decided the starƟng address, be sure that the same address
is configured in the linker.
In order to guarantee the maximum security level, the bootloader allows the final image to take
50www.secube.eu

www.secube.eu
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the full control of the hardware. On this purpose your image shall remap the interrupts vector
table as soon as possible, as shown in the following code:

/* new vector table in RAM */
uint32_t vectorTable_RAM[256] __attribute__(( aligned (0x200ul)

));

/* vector table ROM */
extern uint32_t __Vectors[];

int main(void)
{

// Hardware Abstraction Layer Initialisation
HAL_Init();

// Configure the system clock
SystemClock_Config();

// Remapping Interrupt Vector (overload the USB Loader
Interrupt Vector)

uint32_t i;
for (i = 0; i < 256; i++) {

vectorTable_RAM[i] = __Vectors[i];
/* copy vector table to RAM */
}
// Interrupt Remapping
__disable_irq();
SCB−>VTOR = (uint32_t)&vectorTable_RAM;
__DSB();
__enable_irq();

SystemCoreClockUpdate();
...

}
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As shown in Figure 41, the injecƟon can be executed through the USB Loader Tool, which comes
together with the USEcube™ SƟck.

Figure 41: SEcube™ USB Loader.

TheUSB Loader Tool recognizes theUSEcube™SƟck in BootMode, whichmeans that the firmware
image has not been yet injected, and allows developers/users to inject a custom binary image in
the internal flash. The base address is parametric and, as stated before, must be coherent with
the linker seƫngs.
To prevent unauthorized people to inject firmware in your USEcube™ SƟck, a unique AcƟvaƟon
Key is delivered when the device is acquired.
Please note that the procedure described in this Chapter is sƟll under tesƟng and it is provided as
a reference example, only.
It is very important that your binary image is well tested to run properly on the final device. It is
also suitable for your firmware to support an in-line programming funcƟonality to allow users to
update the USEcube™ SƟck firmware in the future.
To demonstrate this funcƟonality, the SDK provides L0_bootmode_reset(): a dedicated API,
that invalidates the signature of the firmware. Consequently, on the following startup, theUSEcube™
SƟck will be again recognized as a device in Boot Mode, allowing the injecƟon of a new firmware.
An example of usage of this funcƟon is shown in the following code.

int main() {
se3_disco_it it;
se3_device dev;
L0_discover_init(&it);

while (L0_discover_next(&it)) {
se3_device dev;

// Open SEcube device
if (SE3_OK != L0_open(&dev, &it.device_info, 1000)) {

//ERROR
return −1;

}

// BOOT MODE RESET
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if (SE3_OK != L0_bootmode_reset(&dev, my_sn)) {
//ERROR
return −2;

}

// Close SEcube device
L0_close(&dev);
//SUCCESS
return 0;

}

9.5 Geƫng Started with configuring the internal FPGA

9.5.1 How to import your own project

By reading first Chapter 5 and then the example listed in 9.3.2, you should have understood how
the CPU-FPGA communicaƟon system should work. You need the programming library for the
FPGA composed by the three files included in the aforemenƟoned example before, you need to
set the GPIOs of the JTAG port of the FPGA as indicated by the piece of code listed there, and you
certainly need a call to the FPGA programming funcƟon in the main(). What is to be subsƟtuted
are the two huge byte arrays present in the file “TEST_FPGA.h” with the bitstream containing the
informaƟon about the pin interface and for programming internally the FPGA through the JTAG.
Such file is generated automaƟcally from your own HDL descripƟon of the FPGA by the Laƫce
Diamond® Deployment Tool aŌer the synthesis steps. What you should do is nothing else than
replace within the file these two arrays with the ones generated by this tool, but this will be
explained in detail the following.

9.5.2 How to create a Laƫce Project

Once your VHDL design has been developed, tested and validated as working with whatever sim-
ulaƟon tool you prefer, the synthesis process must begin. Open Laƫce Diamond® and follow
these steps.

1. Create a new project
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2. Browse to the locaƟon of your HDL project folder and insert an implementaƟon name

3. Add VHDL source files in this step or inside the project by right clicking on the input files
folder

4. Select the correct FPGAmodel. In this case, the SEcube™ FPGA correct version isMachXO2-
LCMXO2-7000HE-5TG144C
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5. In the following window you have to select the Synthesis tool used. Select LATTICE LSE and
click “Next”

6. Open and edit the LPF source file in the secƟon “LPF Constraint File”. This file is really
important, as it is used for mapping I/O signals to pins and for configuring parameters as
the target clock frequency. The file is structured as a set of non-sequenƟal commands.
The command FREQUENCY is used to set the target speed of the design. The command
LOCATE COMP is used to map ports of the top enƟty to I/O pins of the FPGA. The format is
LOCATE COMP "<name_of_the_port[bit_number]>" SITE "<pin_name

>"

Please refer to Appendices A and B to see the corrispondance between pins and physical
signals on the SEcube™ DevKit.

7. Save all current changes
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9.5.3 Synthesis Procedure

1. Go to «Process» tab of the Process Window and select the check marks as in the following.

2. Right-click on “Run” for all the main voices and check if error messages are present in con-
sole

3. At the end of all synthesis steps, go to «Tools » Timing Analysis View» and check if there are
no violaƟon for setup and hold Ɵmes
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If Ɵmes are respected, constraints are wriƩen in black. Otherwise, they are wriƩen in red.
By clicking on the constraint, on the right it is possible to see details about the violaƟng path

4. If there are no problems, go to «Tools » Programmer»
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5. Select “Create a new blank project” on the appearing window

6. Verify the device family and the XCF file name

7. Check “I/O Seƫngs” as in figure
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8. Save the changes applied. This file is necessary for Deployment Tool

9.5.4 Deployment Tool usage

The Deployment Tool has the aim of converƟng the XCF file into the array format needed to pro-
gram the FPGA through the microcontroller.

1. First, open the Deployment Tool and create a new project like in the following

2. Locate the XCF file and click on “Next”
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3. Be sure to check both the marks “Compress VME Data File” and “Convert VME to HEX (.c)
for File-Based Embedded VME” as in figure

4. Click Next and generate the C files containing the two arrays that will be used to program
the FPGA

9.5.5 Puƫng all together

Now that your HDL project is complete, you have to include it in a custom device-side project set
up for working with the FPGA. In order to do that,

1. Import the project as described in secƟon 9.2.1
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2. Import the necessary «File » Import…», select “Filesystem” and press “Next”

3. Browse to the directory where the SDK has been downloaded and then to the path “SE-
cube_SDK/Libraries/Examples/TestFPGA/”

4. Select the files in that folder (FPGA.c, FPGA.h and TEST_FPGA.h); youmight want to set also
“DesƟnaƟon Folder” to “SEcubeDevBoard/ApplicaƟon/src” and then press “Finish”

5. You might want to import also your custom C/C++ files for interacƟng with your design
present on the FPGA. Add them following the same procedure

6. Configure both “Debug” and “Release” configuraƟons from «Project » ProperƟes » C/C++
Build » MCU GCC Compiler » Includes» and add the “DesƟnaƟon folder”

7. Browse on syntheƟzed HDL project folder, check the presence of the .c files with name end-
ingwith “_algo.c” and “_data.c”. These files are containing the twoarrays, gpucAlgoArray
[] and gpucDataArray[] that must be subsƟtuted in the file “TEST_FPGA.h” already in-
cluded in the project, thus subsƟtuƟng the two already present arrays

8. Copy the content of these twoarrays in the corresponding arrays __fpga_alg and__fpga_data
of “TEST_FPGA.h”. In file “FPGA.c”, values of giAlgoSize and giDataSizemust be sub-
sƟtuted with the one wriƩen respecƟvely at the top of the two files generated by the HDL
synthesizer

9. Open the file named “gpio.c” and add the following lines to the funcƟon MX_GPIO_Init
(), needed for configuring the JTAG port used for programming the FPGA:

/*Configure GPIO pin : PE2 */
GPIO_InitStruct.Pin = GPIO_PIN_2;
GPIO_InitStruct.Mode = GPIO_MODE_INPUT;
GPIO_InitStruct.Pull = GPIO_NOPULL;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);
/*Configure GPIO pins : PE3 PE4 PE5 PE6 */
GPIO_InitStruct.Pin = GPIO_PIN_3|GPIO_PIN_4|GPIO_PIN_5|

GPIO_PIN_6;
GPIO_InitStruct.Mode = GPIO_MODE_OUTPUT_PP;
GPIO_InitStruct.Pull = GPIO_NOPULL;
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GPIO_InitStruct.Speed = GPIO_SPEED_HIGH;
HAL_GPIO_Init(GPIOE, &GPIO_InitStruct);

10. Now edit the code in “main.c” file including the header file “FPGA.h”

11. Also in “main.c” add a call to B5_FPGA_Programming() funcƟon

12. Save the changes to all files and build the project

13. Connect the DevKit as described in previous secƟon

14. Run the project by right-clicking on it in the Project Explorer and selecƟng the Release binary
under «Target » Program Chip» (i.e., select the label containing the string “/Release”)

Remember that at startup, all the LEDs of the SEcube™ DevKit are in a weak pullup state which
indicates that the programming is advancing. AŌer the programming (that may last up to 2 min-
utes) the LEDs are set on or off or leŌ in the same state depending on what is stated by the HDL
code and the connecƟon done through the LPF file.
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APPENDIX A - SEcube™ Data Sheet
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APPENDIX B - SEcube™ DevKit SchemaƟcs
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APPENDIX C - “main.c” for the HelloWorld applicaƟon

#include <stdlib.h>
#include <stdio.h>
#include <stddef.h>
#include <stdint.h>
#include <stdbool.h>

#include "secube−host/L1.h"

static uint8_t pin_admin[32] = {
'a','d','m','i','n', 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0,
0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0

};

int main() {
se3_disco_it it;
se3_device dev;
se3_session s;
uint16_t return_value = 0;
bool logged_in = false;

printf("Welcome to the SEcube Hello World application!");
printf("\n\n\n");
Sleep(1000);

printf("Looking for SEcube devices...\n");
Sleep(3000);

L0_discover_init(&it);
if (L0_discover_next(&it)) {

printf("SEcube device found!");
return_value = L0_open(&dev, &(it.device_info), SE3_TIMEOUT)

;
}
if (return_value != SE3_OK) {

printf("Error opening device.\nPlease check board connection
.\n\n");

Sleep(3000);
return(1);

}
else {

printf("Open Device success\n");
}

/* Log in */
printf("Logging in as admin...\n");
Sleep(3000);
return_value = L1_login(&s, &dev, pin_admin, SE3_ACCESS_ADMIN)

;
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if (return_value != SE3_OK) {
printf("Error, login failed.\nPlease check security pin.\n\n

");
Sleep(3000);
return(2);

}
else {

printf("Login success\n");
logged_in = true;

}
/* */

if (logged_in){
printf("You are logged in SEcube device!");

}

/* Log out */
printf("Logging out...\n");
Sleep(3000);
return_value = L1_logout(&s);
if (return_value != SE3_OK) {

printf("Error, logout failed.\nPlease check board connection
.\n\n");

Sleep(3000);
return(3);

}
else {

printf("Logout success\n");
printf("\n\nConnection to SEcube device was successful\n");
printf("Press [ENTER] to finish\n");

}
/* */

getchar();
return (0);

}
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